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Introduction

To get maximum versatility from this machine all operators should carefully read and follow the in-
structions in this manual. Please keep this manual in a handy place near the machine.

Please read the Safety Information in the "Setup Guide" before using this machine. It contains impor-
tant information related to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Important

Parts of this manual are subject to change without prior notice. In no event will the company be liable for di-
rect, indirect, special, incidental, or consequential damages as a result of handling or operating the machine.

Software Version Conventions Used in This Manual

¢ NetWare 3.x means NetWare 3.12 and 3.2.
¢ NetWare 4.x means NetWare 4.1, 4.11 and IntranetWare.

Trademarks

Apple, AppleTalk, EtherTalk, LaserWriter, Macintosh are registered trademarks of Apple Computer, Inc.
Ethernet is a registered trademark of Xerox Corporation.

Microsoft, Windows, Windows NT are registered trademarks of Microsoft Corporation in the United
States and/or other countries.

Netscape, Netscape Navigator are registered trademarks of Netscape Communications Corporation.
Novell, NetWare, NDS are registered trademarks of Novell, Inc.

PostScript is a registered trademark of Adobe Systems, Incorporated.

PCL is a registered trademark of Hewlett-Packard Company.

Solaris is a trademark or registered trademark of Sun Microsystems, Inc. in the United States and other
countries.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.



Administrator Reference 2

Note

The proper names of the Windows operating systems are as follows:

+ Microsoft® Windows® 95 operating system

+ Microsoft® Windows® 98 operating system

»  Microsoft® Windows® Millennium Edition (Windows Me)
 Microsoft® Windows® 2000 Professional

+ Microsoft® Windows® 2000 Server

+ Microsoft® Windows NT® Server operating system Version 4.0

» Microsoft® Windows NT® Workstation operating system Version 4.0
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How to Read This Manual

Symbols

In this manual, the following symbols are used:

/\ WARNING:

This symbol indicates a potentially hazardous situation which, if instructions are not followed, could
result in death or serious injury.

/\ CAUTION:

This symbol indicates a potentially hazardous situation which, if instructions are not followed, may re-
sult in minor or moderate injury or damage to property.

* The statements above are notes for your safety.

1¥Important
If this instruction is not followed, paper might be misfed, originals might be damaged, or data might be
lost. Be sure to read this.

] Preparation
This symbol indicates the prior knowledge or preparations required before operating.

& Note

This symbol indicates precautions for operation, or actions to take after misoperation.

® Limitation

This symbol indicates numerical limits, functions that cannot be used together, or conditions in which
a particular function cannot be used.

A Reference
This symbol indicates a reference.
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[ 1

Keys that appear on the machine's panel display.
Keys and buttons that appear on the computer's display.

L 1

Keys built into the machine's operation panel.
Keys on the computer's keyboard.




4 Administrator Reference 2

1. Windows 2000 Print Server Configuration

Configuring the Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the Network Interface Board and Windows 2000 to use the
TCP/IP protocol and IPP.

Configuring the printer

Configure the printer to use the TCP/IP protocol.
» Confirm that the TCP/IP protocol is set to be active. (The factory default is active.)
* Assign an IP address and make other settings required for using the TCP/IP protocol.

A Reference
O For more information about how to make the above settings, see "Windows 2000 Configuration" in
Printer Client Reference 1 that comes with this printer.

O If DHCP is used to assign IP addresses, see p.173 “When Using DHCP”.

& Note
3 After setting the IP address, use the ping command to confirm that it has been set correctly.
@ Click [Start], point to [Programs], point to [Accessories] and then click [Command Prompt].
@ Type the following. (Example IP address is 192.168.15.16)
C:> ping 192.168.15.16
If the address has been configured correctly, the following message appears.
Reply from 192.168.15.16 : bytes=32 time<lOms TTL=32
If the address has been configured incorrectly, the following message appears.
Request timed out.
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Configuring a Windows 2000 computer

Follow these steps to configure a Windows 2000 computer to use the TCP/IP protocol.
l] Click [Start] on the taskbar, point to [Settings], and then click [Network and Dial-up Connections].
ﬂ Click [Local Area Connection]. On the [File] menu, click [Properties].

B Confirm that "Internet Protocol (TCP/IP)" is selected in the [Components checked are used by
this connection:] box under the [General] tab.

& Note
3 If the check box of TCP/IP protocol is not selected, select the box.

3 If the TCP/IP protocol is not installed, click [Install] under the [General] tab and install it. For more
information about installing the TCP/IP protocol, see Windows 2000 Help file.

ﬂ Configure the TCP/IP protocols with the appropriate IP address, subnet mask and other set-
tings.
Confirm with the network administrator that the settings are correct.
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Configuring NetBEUI for Printing

Follow these instructions to configure the Network Interface Board and Windows 2000 to use the Net-
BEUI protocol.

Configuring the printer

Configure the printer to use the NetBEUI protocol.
* Confirm that the NetBEUI protocol is set to be active. (The factory default is active.)

A Reference
O For more information about how to make the above settings, see "Windows 2000 Configuration" in
Printer Client Reference 1 that comes with this printer.

Configuring a Windows 2000 computer

Follow these steps to configure a Windows 2000 computer to use the NetBEUI protocol.
l] Click [Start] on the taskbar, point to [Settings], and then click [Network and Dial-up Connections].
ﬂ Click [Local Area Connection]. On the [File] menu, click [Properties].

B Confirm that ""NetBEUI Protocol" is selected in the [Components checked are used by this con-
nection:] box under the [General] tab.
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& Note
3 If the check box of the NetBEUI protocol is not selected, select the box.

3 Ifthe NetBEUI protocol is not installed, click [Install] under the [General] tab and install it. For more
information about installing the NetBEUI protocol, see Windows 2000 Help file. "Network" instal-
lation installs the PCL 5¢ and RPCS printer driver and SmartNetMonitor for Client. When you
print using TCP/IP, NetBEUI or IPP protocol in Peer-to-Peer Network, you must select this instal-
lation.
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Installing Software

= Preparation

O Select "Network" installation when you use the printer for direct printing.

3 "Network" installation installs the PCL 5¢ and RPCS printer driver and SmartNetMonitor for Client.
When you print using TCP/IP, NetBEUI or IPP protocol in Peer-to-Peer Network, you must select
this installation.

3 "Custom" installation allows to install SmartNetMonitor for Client separately.

Installing by "Network™ installation

n Close all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.
The installer will start by Auto Run.

& Note
O Auto Run might not automatically work with certain OS settings. In this case, launch "INST-
TOOL.EXE" located on the CD-ROM root directory.

B Follow the instructions on the screen.
ﬂ Select ""Network'' installation when the selection screen appears.
B Follow the instructions on the screen.

E Select a printer you want to use when the [Select Printer] dialog box appears.
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ﬂ Click [Add..] when the [Select Port] dialog box appear.

B Select [SmartNetMonitor for Client] and then click [OK].
Available printers will be listed.

g Select a printer you want to use.

TCP/IP

@ Select the printer you want to use, and then click [OK].

& Note
3 Printers that respond to an IP broadcast from the computer will be displayed. To print to a
printer not listed here, click [Specify Address] and then type the IP address or host name.

NetBEUI

@ Click [NetBEUI].
A list of printers that can be printed by the NetBEUI protocol appears.
@ Select the printer you want to use, and then click [OK].

& Note

3 Printers that respond to an broadcast from the computer will be displayed. To print to a printer
not listed here, click [Specify Address] and then type the NetBEUI address. Confirm the Net-
BEUI address on the network configuration page. For more information about the printing of
configuration page, see p.173 “When Using DHCP”.

3 You cannot print to printers beyond routers.
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IPP

@ Click [IPP].
The IPP setting dialog box appears.

@ In [Printer URL], type "http://(printer's IP address)/printer' as the IP address of the print-
er.

© As necessary, type the names to distinguish the printer in [IPP Port Name]. Type a name dif-
fering from those of any existing port names.
If you omit this, the address entered in [Printer URL] will be set as the IPP port name.
(Example IP address is 192.168.15.16)
http://192.168.15.16/printer

@ If using a proxy server and IPP user name, click [Detailed Settings] and configure the nec-
essary settings.

& Note
O For more information about these setting, see the Help file.

[m Click [OK].
m Confirm the selected port is highlighted, and then click [Next].

B Ciick [Finish].

& Note
O During installation, the [Digital Signature Not Found] dialog box may appear. In this case, click [Yes]
to continue the installation.

[B Restart the computer after installation is complete.

7
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m Set up the options with the printer driver.

& Note

3 You can specify the "User Code" with the printer properties after installing the printer driver. See
the Help file for the printer driver.

3 You must set up the options when the bidirectional transmission is unable. For more information
about the conditions of the bidirectional transmission, see p.23 “The conditions of the bidirection-
al transmissions”.

Changing Port Settings

Follow the steps to change SmartNetMonitor for Client settings, such as the proxy server settings or
IPP URL.

& Note
O There are no settings for the NetBEUI protocol.

n From the [Printers] window, click the icon of the printer you want to use. On the [File] menu,
click [Properties].
B Click the [Ports] tab, and then click [Configure Port].
The [Port Settings] dialog box appears
* For TCP/IP protocol, you can configure Timeout Settings.
* For IPP, you can configure User Settings, Proxy Settings and Timeout Settings.

& Note
3 For more information about these settings, see SmartNetMonitor for Client Help file.

g



Administrator Reference 2

Printing with a Standard TCP/IP Port

= Preparation
3 Select [Typical] installation when you use the printer with Standard TCP/IP port.

3 [Typical] installation installs the PCL 5¢ and RPCS printer driver.

Installing the Printer Driver

n Close all applications that are running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer will start by Auto Run.

{¥Important

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note
O Auto Run might not automatically work with certain OS settings. In this case, launch "INST-
TOOL.EXE" located on the CD-ROM root directory.

B Follow the instructions on the screen.
ﬂ Select [Typical] installation, and then click [Next].

B Follow the instructions on the screen.
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E Select [Standard TCP/IP] when the "'Select Port' dialog box appears, and then click [Next].
ﬂ Click [Next] in the ""Add Standard TCP/IP Printer Port Wizard'' window.

B Type the printer name or IP address in the ''Printer Name or IP Address'' box.

g Click [Finish] in the '""Add Standard TCP/IP Printer Port Wizard" window.

[m Confirm that the selected port has been displayed in the '"Port'" box, and then click [Next].

& Note

3 During installation, the [Digital Signature Not Found] dialog box may appear. In this case, click [Yes]
to continue the installation.

@ ciick Finish].

& Note

3 You can specify the "User Code" with the printer properties after installing the RPCS pritner driv-
er. See the Help file for the printer driver.

m Restart the computer after the installation is complete.
[B Set up the options with the printer driver.
m You must set up the options when the bidirectional transmission is disabled.

~ Reference

3 For more information about the status of the bidirectional transmission, see p.23 “The conditions
of the bidirectional transmissions”.

O For more information about settings for options, see p.22 “Setting Up Options”.
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Configuring LPR Port Printing

= Preparation
3 Select [Typical] installation when you use the printer with the LPR port.

3 [Typical] installation installs the PCL 5¢ and RPCS printer driver.

Installing the Printer Driver

n Close all applications that are running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer will start by Auto Run.

{¥Important

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note
O Auto Run might not automatically work with certain OS settings. In this case, launch "INST-
TOOL.EXE" located on the CD-ROM root directory.

B Follow the instructions on the screen.
ﬂ Select [Typical] installation, and then click [Next].

B Follow the instructions on the screen.
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E Select [LPR Port] when the '""Select Port' dialog box appears, and then click [Next].

ﬂ Type the printer's IP address in the '"Name or address of server providing Ipd'' box.

B Type "lp" in the '"Name of printer or print queue on that server'' box, and then click [OK].
g Confirm that the selected port has been displayed in the '""Port'" box, and then click [Next].
[E] Click [Finish].

& Note

3 During installation, the [Digital Signature Not Found] dialog box may appear. In this case, click [Yes]
to continue the installation.

m Restart the computer after the installation is complete.
m Set up the options with the printer driver.

A Reference
O For more information about settings for options, see p.22 “Setting Up Options”.

& Note

3 You can specify the "User Code" with the printer properties after installing the printer driver. See
the Help file for the printer driver.

3 You must set up the options when the bidirectional transmission is disabled. For more informa-
tion about the status of the bidirectional transmission, see p.23 “The conditions of the bidirection-
al transmissions”.

J/_/
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Setting Up Options
You must set up installed options, paper size and feed direction with the printer driver when the bidi-
rectional transmission is disabled.

? Limitation

3 Changing the printer settings requires Manage Printers permission. Members of the Administrators
and Power Users groups have Manage Printers permission by default. When you set up options,
log on using an account that has Manage Printers permission.

n Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use. On the [File] menu, click [Properties].
B Click the [Accessories] tab.

& Note
3 If you use the RPCS printer driver, Click [Change Accessories] tab.

O If you use the PS printer driver, Click [Device Settings] tab.
ﬂ Select options you have installed from the [Options] group and make any settings you require.

B ciick [oK] .
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’Z'Q'?The conditions of the bidirectional transmissions

When the bidirectional transmissions is enabled, the information about the paper size and feed direction
settings are automatically sent to the printer by the computer. You can also confirm the printer's condi-
tion from your computer.

* The bidirectional transmissions is supported by Windows 95/98/Me, Windows 2000 and Windows
NT 4.0.

 If you use the RPCS ptinter driver and the bidirectional transmissions is enabled, the [Change Ac-
cessories] tab are grayed out.

& Note

3 The RPCS pritner driver supports the bidirectional transmission and update the printer status auto-
matically.

O The PCL 5c printer driver supports the bidirectional transmission, you can update the printer status
manually.

3O The PostScript 3 printer driver does not supports the bidirectional transmission.
To support the bidirectional transmissions, the following conditions below are required.

< Connecting with the parallel interface cable and the USB exchange cable.
* The computer supports the bidirectional transmissions.
* The Interface cable supports the bidirectional transmissions.

» The printer is connected to the computer using the standard parallel interface cable and the par-
allel connector.

* On Windows 2000, the [Enable bidirectional support] is selected and [Enable printer pooling] is
not selected under the [ports] tab.
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% Connecting with the network
* SmartNetMonitor for Client and the TCP/IP protocol are used.

*  On Windows 2000, the [Enable bidirectional support] is selected and [Enable printer pooling] is
not selected under the [ports] tab.

¢ SmartNetMonitor for Client included on the CD-ROM is installed.
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Setting the Printer Shared

® Limitation

3 Changing the printer settings requires Manage Printers permission. Members of the Administrators
and Power Users groups have Manage Printers permission by default. When you set up options,
log on using an account that has Manage Printers permission.

n Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use. On the [File] menu, click [Properties].
B Select [Shared as:] under the [Sharing] tab.
ﬂ Click [OK].
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2. Windows NT 4.0 Print Server Configuration

Configuring the Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the Network Interface Board and Windows NT to use the TCP/IP
protocol and IPP.

Configuring the printer

Configure the printer to use the TCP/IP protocol.
» Confirm that the TCP/IP protocol is set to be active. (The factory default is active.)
* Assign an IP address and make other settings required for using the TCP/IP protocol.

A Reference
O For more information about how to make the above settings, see "Windows NT 4.0 Configuration"
in Printer Client Reference 1 that comes with this printer.

O If DHCP is used to assign IP addresses, see p.37 “The conditions of the bidirectional transmissions”.

& Note
3 After setting the IP address, use the ping command to confirm that it has been set correctly.
@ Click [Start], point to [Programs], and then click [Command Prompt].
@ Type the following. (Example IP address is 192.168.15.16)
C:> ping 192.168.15.16
If the address has been configured correctly, the following message appears.
Reply from 192.168.15.16 : bytes=32 time<lOms TTL=32
If the address has been configured incorrectly, the following message appears.
Request timed out.
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Configuring a Windows NT computer

Follow these steps to configure a Windows NT computer to use the TCP/IP protocol.

n Open [Control Panel] and double-click the [Network] icon. Confirm that '""TCP/IP Protocol" is
listed in the [Network protocols] box under the [Protocols] tab.

& Note
3 If the TCP/IP protocol is not installed, click [Add] under the [Protocols] tab and install it. For more
information about installing the TCP/IP protocol, see Windows NT Help file.

ﬂ Configure the TCP/IP protocols with the appropriate IP address, subnet mask and other set-
tings.
Confirm with the network administrator that the settings are correct.

B Click the [Services] tab, and confirm that '"Microsoft TCP/IP Printing" is installed.

If "Microsoft TCP/IP Printing" is not installed, click [Add] under the [Services] tab, and install it.
For more information about installing and configuring network services, see Windows NT Help file.
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Configuring NetBEUI for Printing

Follow these instructions to configure the Network Interface Board and Windows NT to use the Net-
BEUI protocol.

Configuring the printer

Configure the printer to use the NetBEUI protocol.
* Confirm that the NetBEUI protocol is set to be active. (The factory default is active.)

A Reference
3 For more information about how to make the above settings, see "Windows NT 4.0 Configuration"
in Printer Client Reference 1 that comes with this printer.

Configuring a Windows NT computer

Install the NetBEUI protocol on the Windows N'T computer, and change the LAN adapter number (La-
na Number).

n Open [Control Panel] and double-click the [Network] icon. Confirm that ''"NetBEUI Protocol"' is
listed in the [Network Protocols] box under the [Protocols] tab.

& Note

3 If the NetBEUI protocol is not installed, click [Add...] under the [Protocols] tab, and install it. For
more information about installing the NetBEUI protocol, see Windows NT Help file.

B Change the Lana Number. Click the [Services] tab, click '"NetBIOS Interface' in the [Network
Services:] box , and click [Properties:].
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B Click the Lana Number corresponding the Nbf protocol of the [Network Route] headline, and
click [Edit].

ﬂ Type ''0" as the Lana Number.

& Note

3 If the other protocol's Lana Number is configured with "0", you must change the Lana Number a
number other than "0".

B Click [OK].
E Click [Close], and close the [Network] dialog box.
ﬂ After confirming the message to restart, click [Yes].

& Note
O After you change the Lana Number, you must restart the computer.
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Installing Software

= Preparation

O Select "Network" installation when you use the printer for direct printing.

3 "Network" installation installs the PCL 5¢ and RPCS printer driver and SmartNetMonitor for Client.
When you print using TCP/IP, NetBEUI or IPP protocol in Peer-to-Peer Network, you must select
this installation.

3 "Custom" installation allows to install SmartNetMonitor for Client separately.

Installing by "Network™ installation

n Close all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.
The installer will start by Auto Run.

& Note
O Auto Run might not automatically work with certain OS settings. In this case, launch "INST-
TOOL.EXE" located on the CD-ROM root directory.

B Follow the instructions on the screen.
ﬂ Select ""Network'' installation when the selection screen appears.
B Follow the instructions on the screen.

E Select a printer you want to use when the [Select Printer] dialog box appears.
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ﬂ Click [Add..] when the [Select Port] dialog box appear.

B Select [SmartNetMonitor for Client] and then click [OK].
Available printers will be listed.

g Select a printer you want to use.

TCP/IP

@ Select the printer you want to use, and then click [OK].

& Note
3 Printers that respond to an IP broadcast from the computer will be displayed. To print to a
printer not listed here, click [Specify Address] and then type the IP address or host name.

NetBEUI

@ Click [NetBEUI].
A list of printers that can be printed by the NetBEUI protocol appears.
@ Select the printer you want to use, and then click [OK].

& Note

3 Printers that respond to an broadcast from the computer will be displayed. To print to a printer
not listed here, click [Specify Address] and then type the NetBEUI address. Confirm the Net-
BEUI address on the network configuration page. For more information about the printing of
configuration page, see p.37 “The conditions of the bidirectional transmissions”.

3 You cannot print to printers beyond routers.
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IPP

@ Click [IPP].
The IPP setting dialog box appears.

@ In [Printer URL], type "http://(printer's IP address)/printer' as the IP address of the print-
er.

© As necessary, type the names to distinguish the printer in [IPP Port Name]. Type a name dif-
fering from those of any existing port names.
If you omit this, the address entered in [Printer URL] will be set as the IPP port name.
(Example IP address is 192.168.15.16)
http://192.168.15.16/printer

@ If using a proxy server and IPP user name, click [Detailed Settings] and configure the nec-
essary settings.

& Note
O For more information about these setting, see the Help file.

[m Click [OK].
m Confirm the selected port is highlighted, and then click [Next].

B Ciick [Finish].

& Note
O During installation, the [Digital Signature Not Found] dialog box may appear. In this case, click [Yes]
to continue the installation.

[B Restart the computer after installation is complete.

7
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m Set up the options with the printer driver.

& Note

3 You can specify the "User Code" with the printer properties after installing the printer driver. See
the Help file for the printer driver.

3 You must set up the options when the bidirectional transmission is unable. For more information
about the conditions of the bidirectional transmission, see p.37 “The conditions of the bidirection-
al transmissions”

Changing Port Settings

Follow the steps to change SmartNetMonitor for Client settings, such as the proxy server settings or
IPP URL.

& Note
O There are no settings for the NetBEUI protocol.

n From the [Printers] window, click the icon of the printer you want to use. On the [File] menu,
click [Properties].
B Click the [Ports] tab, and then click [Configure Port].
The [Port Settings] dialog box appears
* For TCP/IP protocol, you can configure Timeout Settings.
* For IPP, you can configure User Settings, Proxy Settings and Timeout Settings.

& Note
3 For more information about these settings, see SmartNetMonitor for Client Help file.

g
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Configuring LPR Port Printing

= Preparation
3 Select [Typical] installation when you use the printer with the LPR port.

3 [Typical] installation installs the PCL 5¢ and RPCS printer driver.

Installing the Printer Driver

n Close all applications that are running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer will start by Auto Run.

{¥Important

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note
O Auto Run might not automatically work with certain OS settings. In this case, launch "INST-
TOOL.EXE" located on the CD-ROM root directory.

B Follow the instructions on the screen.
ﬂ Select [Typical] installation, and then click [Next].

B Follow the instructions on the screen.
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E Select [LPR Port] when the '""Select Port' dialog box appears, and then click [Next].

ﬂ Type the printer's IP address in the '"Name or address of server providing Ipd'' box.

B Type "lp" in the '"Name of printer or print queue on that server'' box, and then click [OK].
g Confirm that the selected port has been displayed in the '""Port'" box, and then click [Next].
[E] Click [Finish].

& Note

3 During installation, the [Digital Signature Not Found] dialog box may appear. In this case, click [Yes]
to continue the installation.

m Restart the computer after the installation is complete.
m Set up the options with the printer driver.

A Reference
O For more information about settings for options, see p.36 “Setting Up Options”.

& Note

3 You can specify the "User Code" with the printer properties after installing the printer driver. See
the Help file for the printer driver.

3 You must set up the options when the bidirectional transmission is disabled. For more informa-
tion about the status of the bidirectional transmission, see p.37 “The conditions of the bidirection-
al transmissions”.

J/_/
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Setting Up Options
You must set up installed options, paper size and feed direction with the printer driver when the bidi-
rectional transmission is disabled.

? Limitation

3 Changing the printer settings requires Full Control Access permission. Members of the Administra-
tors and Power Users groups have Full Control Access permission by default. When you set up op-
tions, log on using an account that has Full Control Access permission.

n Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use. On the [File] menu, click [Properties].
B Click the [Accessories] tab.

& Note
3 If you use the RPCS printer driver, Click [Change Accessories] tab.
O If you use the PS printer driver, Click [Device Settings] tab.

ﬂ Select options you have installed from the [Options] group and make any settings you require.

B ciick [oK] .
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’Z'Q'?The conditions of the bidirectional transmissions

When the bidirectional transmissions is enabled, the information about the paper size and feed direction
settings are automatically sent to the printer by the computer. You can also confirm the printer's condi-
tion from your computer.

* The bidirectional transmissions is supported by Windows 95/98/Me, Windows 2000 and Windows
NT 4.0.

 If you use the RPCS ptinter driver and the bidirectional transmissions is enabled, the [Change Ac-
cessories] tab are grayed out.

& Note

3 The RPCS pritner driver supports the bidirectional transmission and update the printer status auto-
matically.

O The PCL 5c printer driver supports the bidirectional transmission, you can update the printer status
manually.

3O The PostScript 3 printer driver does not supports the bidirectional transmission.
To support the bidirectional transmissions, the following conditions below are required.

< Connecting with the parallel interface cable and the USB exchange cable.
* The computer supports the bidirectional transmissions.
* The Interface cable supports the bidirectional transmissions.

» The printer is connected to the computer using the standard parallel interface cable and the par-
allel connector.

* On Windows NT 4.0, the [Enable bidirectional support] is selected and [Enable printer pooling]
is not selected under the [ports] tab.
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% Connecting with the network
* SmartNetMonitor for Client and the TCP/IP protocol are used.

*  On Windows NT 4.0, the [Enable bidirectional support] is selected and [Enable printer pooling]
is not selected under the [ports] tab.

¢ SmartNetMonitor for Client included on the CD-ROM is installed.
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Setting the Printer Shared

® Limitation

3 Changing the printer settings requires Full Control Access permission. Members of the Administra-
tors and Power Users groups have Full Control Access permission by default. When you set up op-
tions, log on using an account that has Full Control Access permission.

Use the [Printers] window to set up the printer.

n Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use. On the [File] menu, click [Properties].
B Select [Shared] in the [Sharing] tab.

& Note
3 If you use alternate drivers for Windows 95/98/Me client, service pack 4 or more is required. And
install the appropriate printer driver for each client.
ﬂ Click [OK].
The printers attached to the network are displayed.
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3. NetWare Configuration

This chapter describes how to configure the printer to use as a print server or a remote printer in a Net-
Ware environment.

& Note

3 NetWare must be set to active using the operation panel of the printer. For more information about
how to set it, see Administrator Reference 1 that comes with this printer.

< SmartNetMonitor for Admin
To use a printer in a NetWare environment, configure the NetWare printing environment by using
SmartNetMonitor for Admin.

& Note

3 If you configure NetWare printing environment by using SmartNetMonitor for Admin under fol-
lowing environment, NetWare Client which is provided by Novell is required.
+ NDS mode in Windows 95/98
« NDS or Bindary mode in Windows 2000/Windows NT4.0

« Printers listed by SmartNetMonitor for Admin
SmartNetMonitor for Admin displays a list of printers, which are connected to the network.
If you cannot find out the printer from the displayed list, refer to the configuration page printed from
the printer. For more information about printing a configuration page, see p.81 “Printing a Config-
uration Page”.
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NetWare 3.x - Advanced Settings

The actual procedures for configuring the printer differ depending on whether the Network Interface
Board is configured as a print server or as a remote printer. This section describes how to configure it
in the NetWare 3.x environment.

s N

Basic Procedure

(Install the SmartNetMonitor for Adminj

Print Server Remote Printer

(Configure the Network Interface Board J

Configure the NetWare

Start the print server

Turn the power
off and on

N J

& Note
3 This section assumes NetWare is functional and that the necessary environment for the NetWare
Print Service is available.

g
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Installing SmartNetMonitor for Admin

n Close all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.
The installer will start by Auto Run.

& Note

O Auto Run might not automatically work with certain OS settings. In this case, launch "INST-
TOOL.EXE" located on the CD-ROM root directory.

B Follow the instructions on the screen.

ﬂ Select ""Custom' installation and then click [Next].

B Remove the check mark from the RPCS Printer Driver and PCL 5c Printer Driver.
E Click to select [SmartNetMonitor for Admin], and then click [Install].

ﬂ Click [OK].

B Follow the instructions on the screen.

After installation is completed, see p.43 “Setting Up as a Print Server” when you use the printer as
a print server.

See p.45 “Setting Up as a Remote Printer” when you use the printer as a remote printer.

& Note

3 If you require restarting the computer after installation of SmartNetMonitor for Admin was com-
pleted, restart the computer and continue to configuration.
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Setting Up as a Print Server

n Log on to the file server as a Supervisor or a Supervisor equivalent.
B Run SmartNetMonitor for Admin.

B Click the [Group] menu and click [Open LAN] and select [IPX/SPX].
A list of printers appears

& Note

3 If you cannot identify which printer to configure from the list of printers, print Configuration Page
from the printer and find the desired printer. For more information about printing Configuration
Page, see p.81 “Printing a Configuration Page”.

O If no printer name appears in the list, match the frame types of the IPX/SPX protocol between
the computer and printer. Use the [Network] dialog box of Windows to change the frame type of
the computer. For more information about changing the frame type of equipment, see "Config-
uring the Printer for the Network™ in Administrator Reference 1.

ﬂ Click to select the printer you want to configure, and then click [NIB Setup Tool] on the [Tools]
menu.

B Click to select [Wizard], and then click [OK].

ﬂ Type the device name into the [Device Name] box and comment into the [Comment] box as nec-
essary, and then click[Next].

ﬂ Select the [NetWare] check box, and then click [Next].



Administrator Reference 2

B Click to select [Bindery Mode], type the file server name into the [File Server Name:] box, and
then click [Next].

In the [File Server Name:] box, type the name of the file server in which a print server is to be created.
You can also select a file server from the list that appears by clicking [Browse].

g Type the print server name into the [Print Server Name] box, printer name into the [Printer
Name] box, and print queue name into the [Print Queue Name] box, and then click [Next].

* In the [Print Server Name] box, type the name of the NetWare print server within 47 characters.
 1In the [Printer Name] box, type the name of the NetWare printer.
* In the [Print Queue Name] box, type the name of the print queue to be added to NetWare.

m After confirming the settings, click [Next].
The settings take effect, and the NIB setup tool exits.

m Exit SmartNetMonitor for Admin.

m Turn the printer power off and on.

& Note
3 To confirm that the printer is configured correctly, type as follows from the command prompt.

F:> USERLIST
3 If the printer works as configured, the name of the print server appears as an attached user.
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Setting Up as a Remote Printer

n Log on to the file server as a Supervisor or a Supervisor equivalent.
B Run the SmartNetMonitor for Admin.

B Click the [Group] menu and click [Open LAN] and select [IPX/SPX].
A list of printers appears.

& Note

3 If you cannot identify which printer to configure from the list of printers, print Configuration Page
from the printer and find the desired printer. For more information about printing Configuration
Page, see p.81 “Printing a Configuration Page”.

O If no printer name appears in the list, match the frame types of the IPX/SPX protocol between
the computer and printer. Use the [Network] dialog box of Windows to change the frame type of
the computer. For more information about changing the frame type of equipment, see "Config-
uring the Printer for the Network™ in Administrator Reference 1.

ﬂ Click to select the printer you want to configure, and then click [NIB Setup Tool] on the [Tools]
menu.

B Click to select [Property Sheet] and click [OK].

E Click the [NetWare] tab, and make the following settings.
@ In the [Print Server Name] box, type the name of the print server.

@ In the [File Server Name] box, type the name of the file server in which a print server is to be
created.

Clicking [Browse], you can select a file server among those listed in the [Browse] dialog box.
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© In the [Print Server Operation Mode] group, click [As Remote Printer].
@ In the [Remote Printer No.] box, type the printer number.

1EImportant
3 Use the same printer number as that to be created in the printer server.

@ Click [OK] to close the property sheet.
O After a confirmation dialog box appears, click [OK].

ﬂ On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

B Type "PCONSOLE'" from the command prompt.
F:> PCONSOLE

g Create a print queue as follows.

& Note
O If you use a currently defined print queue, go to step [l

@ From the [Available Options] menu, select [Print Queue Information] and press [ENTER].
@ Press [INSERT] and type a print queue name.
@ Press [ESC] to return to the [Available Options] menu.

[m Create a printer as follows.
@ From the [Available Options] menu, select [Print Server Information] and press [ENTER ).
@ To create a new print server, press [INSERT] and type a print server name.

If you use an currently defined print server, select one of the print servers shown in the [Print
Server] list.

i@klmportant
0 Use the same name as that specified in the NIB Setup Tool. (Step [3).
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© From the [Print Server Information] menu, select [Print Server Configuration].
@ From the [Print Server Configuration] menu, select [Printer Configuration].
@ Select the printer which is indicated as ""Not Installed"'.

i@klmportant
3 Use the same number as that specified as Remote Printer No. using the NIB Setup Tool.

(Step 3-0).
O If you change the name of the printer, type a new name.
A name "Printer x" is assigned to the printer. x stands for the number of the selected printer.
@ As type, select [Remote Parallel, LPT1].
The IRQ, Buffer size, Starting form, and Queue service mode are automatically configured.
© Press the [ESC] key, and click [Yes] in the confirmation dialog box.
© Press the [ESC] key to return to [Print Server Configuration Menu].

m Assign print queues to the created printer as follows.
@ From [Print Server Configuration Menu], select [Queues Serviced By Printer].
@ Select the printer created in step .
© Press the [INSERT] key to select a queue serviced by the printer.

& Note
3 You can select more than one queue at a time.

@ Follow the instructions on the screen to make other necessary settings.

When you have finished the above steps, confirm that the queues are assigned.

[ﬂ Press the [ESC] key until ""Exit?'" appears, and select [Yes] to exit PCONSOLE.
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[B Start the print server by typing the following from the console of the NetWare Server.
If it is running, restart it after exiting it.

% To exit
CAREE: unload pserver

< To start

CAREE: load pserver print_server_name

& Note
3 If the printer works as configured, "Waiting for job" appears.
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NetWare 4.x, 5 - Advanced Settings

The actual procedures for configuring the printer differ depending on whether the Network Interface
Board is configured as a print server or as a remote printer. This section describes how to configure it
in the NetWare 4.x, 5 environment.

+ To use NetWare 5
If you use Pure IP, use the printer as a print server. You cannot use the printer as a remote printer

when you use Pure IP.

If you use Pure IP, configure the printer to use the TCP/IP protocol. For more information about
how to make the settings, see "Configuring the printer for the Network" in Administrator Refer-

ence 1 that comes with this printer.

Basic Procedure

(Install the SmartNetMonitor for Admin j

Print Server Remote Printer

(Configure the Network Interface Board J

Configure the NetWare

Turn the power Start the print server

off and on
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Installing SmartNetMonitor for Admin

n Close all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.
The installer will start by Auto Run.

& Note

O Auto Run might not automatically work with certain OS settings. In this case, launch "INST-
TOOL.EXE" located on the CD-ROM root directory.

B Follow the instructions on the screen.

ﬂ Select ""Custom' installation and then click [Next].

B Remove the check mark from the RPCS Printer Driver and PCL 5c Printer Driver.
E Click to select [SmartNetMonitor for Admin], and then click [Install].

ﬂ Click [OK].

B Follow the instructions on the screen.

After installation is completed, see p.43 “Setting Up as a Print Server” when you use the printer as
a print server.

See p.45 “Setting Up as a Remote Printer” when you use the printer as a remote printer.

& Note

3 If you require restarting the computer after installation of SmartNetMonitor for Admin was com-
pleted, restart the computer and continue to configuration.
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Setting Up as a Print Server

n Log on to the file server as a Supervisor or a Supervisor equivalent.
B Run SmartNetMonitor for Admin.

B Click the [Group] menu and click [Open LAN] and select [IPX/SPX] or [TCP/IP].
A list of printers appears

& Note
3 If you use Pure IP, select [TCP/IP].

O If you cannot identify which printer to configure from the list of printers, print Configuration Page
from the printer and find the desired printer. For more information about printing Configuration
Page, see p.81 “Printing a Configuration Page”.

3 If no printer name appears in the list, match the frame types of the IPX/SPX protocol between
the computer and printer. Use the [Network] dialog box of Windows to change the frame type of
the computer. For more information about changing the frame type of equipment, see "Config-
uring the Printer for the Network" in Administrator Reference 1.

ﬂ Click to select the printer you want to configure, and then click [NIB Setup Tool] on the [Tools]
menu.

& Note
3 If you use Pure IP, see p.53 “Using Pure IP in the NetWare 5 environment”

B Click to select [Wizard], and then click [OK].

E Type the device name into the [Device Name] box and comment into the [Comment] box as nec-
essary, and then click[Next].
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ﬂ Select the [NetWare] check box, and then click [Next].

m Click to select [NDS Mode], type the file server name into the [File Server Name:] box, the NDS
tree name into the [NDS Tree:] box and the context into the [NDS Context:] box, and then click
[Next].

In the [File Server Name:] box, type the name of the file server in which a print server is to be created.
You can also select a file server from the list that appears by clicking [Browse].

Clicking [Browse], you can select a NDS context among those listed in the [Browse] dialog box.

As a context, object names are typed from a lower object and divided by a period. For example, if
you want to create a print server into NET under DS, type "NET.DS".

g Type the print server name into the [Print Server Name] box, printer name into the [Printer
Name] box, print queue name into the [Print Queue Name] box, and print queue volume into the
[Print Queue Volume], and then click [Next].

 In the [Print Server Name] box, type the name of the NetWare print server within 47 characters.
 In the [Printer Name] box, type the name of the NetWare printer.
* In the [Print Queue Name] box, type the name of the print queue to be added to NetWare.

* Inthe [Print Queue Volume], type the volume of print queue. As a volume, object names are typed
from a lower object and divided by a period. You can select a volume by clicking [Browse].

[m After confirming the settings, click [Next].
The settings take effect, and the NIB setup tool exits.

m Exit SmartNetMonitor for Admin.
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m Turn the printer power off and on.
& Note
3 To confirm that the printer is configured correctly, type as follows from the command prompt.

F:> NLIST USER /A/B
3 If the printer works as configured, the name of the print server appears as an attached user.

Using Pure IP in the NetWare 5 environment

n Log on to the file server as an Admin or an Admin equivalent.
ﬂ Run SmartNetMonitor for Admin.

B Click [Property Sheet] and click [OK].
The [NIB Setup Tool] dialog box appears.

ﬂ Click the [NetWare] tab, and make the following settings.
@ In the [Print Server Name:] box, type the name of the print server.
@ In the [File Server Name:] box, type the name of the file server in which a print server is to
be created.
Clicking [Browse], you can select a file server among those listed in the [Browse File Server] di-

alog box.
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© In the [NDS Context:] box, type the context of the print server.

Clicking [Browse], you can select a NDS tree and a NDS context among those listed in the
[Browse Context] dialog box.

As a context, object names are typed from a lower object and divided by a period. For example,
if you want to create a print server into NET under DS, type "NET.DS".

@ In the [Print Server Operation Mode] group, click [As Print Server].
© Click [OK] to close the property sheet.
@ After a confirmation dialog box appears, click [OK].

B Exit SmartNetMonitor for Admin.
After this step, go to step [f} on p.51 “Setting Up as a Print Server”.
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Setting Up as a Remote Printer

n Log on to the file server as an Admin or an Admin equivalent.
B Run the SmartNetMonitor for Admin.

B Click the [Group] menu and click [Open LAN] and select [IPX/SPX].
A list of printers appears.

& Note

3 If you cannot identify which printer to configure from the list of printers, print Configuration Page
from the printer and find the desired printer. For more information about printing Configuration
Page, see p.81 “Printing a Configuration Page”.

O If no printer name appears in the list, match the frame types of the IPX/SPX protocol between
the computer and printer. Use the [Network] dialog box of Windows to change the frame type of
the computer. For more information about changing the frame type of equipment, see "Config-
uring the Printer for the Network™ in Administrator Reference 1.

ﬂ Click to select the printer you want to configure, and then click [NIB Setup Tool] on the [Tools]
menu.

B Click to select [Property Sheet] and click [OK].

E Click the [NetWare] tab, and make the following settings.
@ In the [Print Server Name] box, type the name of the print server.

@ In the [File Server Name] box, type the name of the file server in which a print server is to be
created.

Clicking [Browse], you can select a file server among those listed in the [Browse] dialog box.
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© In the [NDS Context] box, type the context in which the print server is to be created.
Clicking [Browse], you can select a context among those listed in the [Browse] dialog box.

As an context, object names are typed from a lower level object and divided by a period. For ex-
ample, if you want to create a print server into NET under DS, type "NET.DS".

@ In the [Print Server Operation Mode] group, click [As Remote Printer].
© In the [Remote Printer No.] box, type the number of the printer.

1¥Important
O Use the same number as that of the printer to be created in the print server.

O Click [OK] to close the property sheet.
ﬂ On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.
B From Windows, run NW Admin.

ye Reference
O For more information about NWAdmin, see the documentation that comes with the NetWare.

g Create a print queue as follows.

@ Select the container object the print queue is located in among those in the directory tree,
and click [Create] on the [Object] menu.

@ In the [Class of new object] box, click '"Print Queue'', and click [OK].
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© In the [Print Queue name] box, type the name of the print queue.

@ In the [Print Queue Volume] box, click [Browse] button.

@ In the [Available objects] box, click the volume in which the print queue is created, and click
[OK].

O After confirming the settings, click [Create].

[m Create a printer as follows.
@ Select the container object the printer is located in, and click [Create] in the [Object] menu.

@ In the [Class of new object] box, click "Printer', and click [OK]. When you are using Net-
Ware 5, click '"Printer (Non NDPS)"'.

© In the [Printer name] box, type the name of the printer.
@ Click [Define additional properties] to check a box, and click [Create].

m Assign print queues to the created printer as follows.
@ Click [Assignments], and click [Add] in the [Assignments] group.
@ In the [Available objects] box, click the queue created in step [], and click [OK].

© Click [Configuration], and in the [Printer type] box, select [Parallel] using the drop-down
menu, and then click [Communication].

@ Click [Manual load] in the [Communication type] group, and click [OK].
@ After confirming the settings, click [OK].

m Create a print server as follows.
@ Select the context specified using the NIB Setup Tool (Step [J-€)), and on the [Object] menu,
click [Create].

@ In the [Class of new object] box, click ''Print Server'', and click [OK]. When you are using
NetWare 5, click '"'Print Sever (Non NDPS)".
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© In the [Print Server name] box, type the name of the print server.

i%klmportant
O Use the same name as that specified using the NIB Setup Tool. (Step [J).

@ Click [Define additional properties] to check a box, and click [Create].

[B Assign the printer to the created print server as follows.
@ Click [Assignments], and click [Add] in the [Assignments] group.
@ In the [Available objects] box, click the queue created in the step (], and click [OK].
© In the [Printers] group, click the printer assigned in step @ , and click [Printer Number].
@ Type the printer number and click [OK].

ﬂlmportant
O Use the same number as that specified as Remote Printer No. using the NIB Setup Tool.

(Step 3-©).
@ After confirming the settings, click [OK].

m Start the print server by typing the following from the console of the NetWare Server.
If it is running, restart it after exiting it.

% To exit
CAREE: unload pserver

< To start
CAREE: load pserver print_server_name
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4. Monitoring and Configuring the Printer

Changing Names and Comments

You can change printer names and make a comment on printers to ease your identifying the printers
listed on SmartNetMonitor for Client.

The following utilities are used to change printer names and comments.

< SmartNetMonitor for Admin
Allows you to change names and comments when the TCP/IP protocol or IPX/SPX protocol is
available. You can install SmartNetMonitor for Admin from the CD-ROM that comes with the
printer. For more information about installing SmartNetMonitor for Admin, see p.50 “Installing
SmartNetMonitor for Admin”.

% Web Browser
Allows you to change names and comments when the TCP/IP protocol is available.

& Note

3 Each of the names, in a TCP/IP protocol form (printer name) and in a NetBEUI protocol form, is
changed individually. Comments are, however, common to both of them.

O The factory default name consists of "RNP" and the last 3 bytes of the MAC address of the net-
work interface board. For example, when the MAC address is 00:00:74:62:7D:D5, the factory de-
fault name is "RNP627DD5". Comments are not configured.
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SmartNetMonitor for Admin

n Run SmartNetMonitor for Admin.

B Click the [Group] menu, point to [Open LAN], and select [TCP/IP] or [IPX/SPX]. A list of printers
appears.

& Note
3 Select the protocol of the printer you want to change the settings.

B On the list, click to select the printer whose network interface board you want to change the
settings.

ﬂ From the [Tools] menu, select [NIB Setup Tool].
The NIB Setup Tool starts up.

B Select [Property Sheet], and then click [OK].

TCP/IP

@ Click the [General] tab, and then type the name into the [Device Name] box and comment
into the [Comment] box.

* 1In the [Device Name] box, type the name of the printer within 47 characters. The factory de-
fault name consists of "RNP" and the last 3 bytes of the MAC address of the network interface
board. For example, when the MAC address is 00:00:74:62:7D:D35, the factory default name
is "RNP627DD5". No name of 9 characters is permitted if prefixed with "RNP". Also, when
DHCEP is selected as an IP address setting, the number of characters is limited to within 13
characters.

* In the [Comment] box, type any comment on printers within 31 characters.
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NetBEUI

@ Click the [General] tab, and then type the comment into the [Comment] box.
In the [Comment] box, type any comment on printers within 31 characters.

@ Click the [NetBEUI] tab.

© Type the name into the [Computer Name] box.

 In the [Computer Name] box, type the name that helps you to identify printers using the Net-
BEUI protocol. The factory default name consists of "RNP" and the last 3 bytes of the MAC
address of the network interface board. For example, when the MAC address is
00:00:74:62:7D:DS5, the factory default name is "RNP627DD5". A maximum of 13 charac-
ters of capital English letters, numeric, or symbols (except "*+,/:;<=>?[\]|. and space) can be
used. No name is permitted if prefixed with "RNP". You must avoid the duplication of the
same name on a network.

* In the [Comment] box, type any comment on printers within 31 characters.

E Click [OK].
The NIB Setup Tool exits, and the setting is transmitted to the printer.

ﬂ Exit SmartNetMonitor for Admin.
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Web Browser

n Run the Web browser.

B Type the address "http:// (IP address of the printer you want to change the settings)''.
The status of the selected printer is displayed on the Web browser.

B Click [Configuration].
A dialog box that prompts you to type the user name and password appears.

ﬂ Type the user name and password, and then click [OK].
Type only the password in this dialog box. The factory default password is "password".

B Change names and comments.

TCP/IP

@ Click the [General] tab, and then type the name into the [Printer Name] box and comment
into the [Comment] box.

* In the [Printer Name] box, type the name of the printer within 47 characters. The factory de-
fault name consists of "RNP" and the last 3 bytes of the MAC address of the network interface
board. For example, when the MAC address is 00:00:74:62:7D:D35, the factory default name
is "RNP627DD5". No name of 9 characters is permitted if prefixed with "RNP". Also, when
DHCEP is selected as an IP address setting, the number of characters is limited to within 13
characters.

* In the [Comment] box, type any comment on printers within 31 characters.
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NetBEUI

@ Click [NetBEUI].
@ Type the name into the [Computer Name] box and comment into the [Comment] box.

* In the [Computer Name] box, type the name that helps you to identify printers using the Net-
BEUI protocol. The factory default name consists of "RNP" and the last 3 bytes of the MAC
address of the network interface board. For example, when the MAC address is
00:00:74:62:7D:D5, the factory default name is "RNP627DD5". A maximum of 13 charac-
ters of capital English letters, numeric, or symbols (except "*+,/:;<=>?[\]|. and space) can be
used. No name is permitted if prefixed with "RNP". You must avoid the duplication of the
same name on a network.

* In the [Comment] box, type any comment on printers within 31 characters.

E Click [Apply].

The setting is transmitted to the printer.

ﬂ Exit the Web browser.
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Displaying the Status of Printer

You can view the status of printers using SmartNetMonitor for Admin, SmartNetMonitor for Client, or
Web browser.

SmartNetMonitor for Admin

n Run SmartNetMonitor for Admin.
ﬂ Click the [Group] menu, point to [Open LAN], and select [TCP/IP] or [IPX/SPX].

The status of printers is indicated with an icon in the list.

& Note
3 For more information about the status icons, see the Help file.

B To get further information, click the desired printer to select from the list, and then click
[Open] on the [Device] menu.

The status of the printer is displayed on a dialog box.

& Note
3 For more information about each item on the dialog box, see the Help file.
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SmartNetMonitor for Client

To view the status of printers using SmartNetMonitor for Client, you must, in advance, configure
SmartNetMonitor for Client so it monitors the printer whose status you want to view.

Monitoring Printers

n Run SmartNetMonitor for Client.
The SmartNetMonitor for Client icon appears at the right end of the taskbar.

ﬂ Right-click the SmartNetMonitor for Client icon, and check if the desired printer is config-
ured on the pop-up menu that appears.
If it is configured, see p.66 “Displaying the Status of Printers”.

B If the desired printer is not configured, click [Options] on the pop-up menu.
The [SmartNetMonitor for Client - Options] dialog box appears.

ﬂ Click the printer to be monitored, and select the [To Be Monitored] check box from the [Moni-
toring Information Settings] group.

& Note

O Selecting the [Displayed on Task Bar] check box will bring up the status of a printer with an icon on
the SmartNetMonitor for Client icon on the task tray.

B ciick [0k

The dialog box closes and the configured printer is monitored.
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Displaying the Status of Printers

n Run SmartNetMonitor for Client.
B The status of printers is displayed on the SmartNetMonitor for Client icon on the task tray.

& Note
3 For more information about the status icons, see the Help file.

B To get further information on the status, right-click the SmartNetMonitor for Client icon and
click the desired printer.

The status of the printer is displayed on a dialog box.

& Note
3 For more information about each item on the dialog box, see the Help file.

Web Browser

n Run the Web browser.

ﬂ Type the address '"http:// (IP address of the printer whose status you want to view)"'.
The status of the selected printer is displayed on the Web browser.

B Click [Status] and you can check the status of the printer.

& Note
O For more information about each item, see the Help file.
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5. Making Printer Settings with the Operation Panel
Menu Chart

This section describes how to change the default settings of the printer and provides information on the
parameters included in each menu.

Category Function menu
Sample Print *! Select Action / Error File(s)
Locked Print ! Select Action / Error File(s)
Paper Input = p.73 Bypass Size
Tray Paper Size
Paper Type
Tray Locking
Tray Priority
List/Test Print = p.80 Config. Page
Menu List

Color Demo Page
PS Config. Page
PCL Config.Page
Hex Dump

Maintenance = p.87 Color Regist.

Image Density

Registration Prt. Test Sheet

Adjustment

HDD Format

Menu Protect *2
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Category

Function menu

System = p.93

MisfeedRecovery

Prt. Err Report

Auto Continue

Memory Overflow

Sub Paper Size

Page Size

Duplex

Output Tray

Job Separation

Energy Saver 1

Energy Saver 2

B&W Page Detect

Unit of Measure

Resolution

PCL
PS3
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Category Function menu
Host Interface = p.102 1/0 Buffer
I/O Timeout
Network Setup IP Address
Subnet Mask
Gateway Address
Access Control
Access Mask
Network Boot
Frame Type (NW)
Active Protocol
Ethernet
PCL Menu = p.109 Orientation
Form Lines

Font Source

Font Number

Point Size
Font Pitch
Symbol Set

Language = p.115

*I' The "Sample Print" menu and the "Locked Print" menu appear only when the optional Hard Disk Drive
is installed.

2 While the printer is On Line, press [Enter], and then press [Escape], finally press [Menu]. You can
access the "Menu Protect" on the panel display.
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Accessing the Main Menu

Press [Menu], and "Menu" appears on the panel display.

ZDJS001N

This menu shows the following 9 items which can be displayed one by one pressing [A] or [V].
* Sample Print

* Locked Print

* Paper Input

» List/Test Print

* Maintenance

* System

* Host Interface

* PCL Menu

* Language
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& Note

O If the optional Hard Disk Drive is not installed, the "Sample Print" menu and the "Locked Print" menu
cannot be displayed on the operation panel.

O [v]: Press to go to the next page.
O [A]): Press to go back to the previous page.
O After making the printer settings, be sure to return to the previous menu by pressing [Escape].

ZDJS024N
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O After making the printer settings, press [On Line] to return to the "Ready " condition.

ZDJS022N

O The revised settings are not canceled even if the power switch is turned off.
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Paper Input Menu

There are 5 menu items in the "Paper Input" menu.

* Bypass Size

* Tray Paper Size

» Paper Type

* Tray Locking

* Tray Priority

~ Reference

3 For more information about loading paper in the tray, see the Setup Guide.

Paper Input Parameters

Menu Description

Bypass Size The paper size for the bypass tray.

For more information about paper sizes that can be set in the bypass tray, see "Pa-
per and Other Media" in Maintenance Guide 2.

Tray Paper Size The paper size for Tray 2, optional tray 3 and tray 4.

For more information about paper sizes that can be set in each tray, see Mainte-
nance Guide 2.

& Note
3 Only the installed trays appear on the panel display.
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Menu

Description

Paper Type

If you use different kinds of paper, you set the paper type for Tray 1, Tray 2, Tray
3 or Bypass Tray.

For more information about paper sizes that can be set in each tray, see Mainte-
nance Guide 2.

< Tray 1, Tray 2, Tray 3, Tray 4
Plain Paper, Recycled Paper, Special Paper, Color Paper, Letterhead, Pre-
printed, Prepunched, Bond Paper, Cardstock

< Bypass Tray
Plain Paper, Recycled Paper, Special Paper, Color Paper, Letterhead, Pre-
printed, Prepunched, Bond Paper, Cardstock, Transparency, Thick Paper,
Plain:Dup.Back, Thick:Dup.Back

& Note
3 Default : Plain Paper
3 Only the installed trays appear on the panel display.
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Menu

Description

Tray Locking

If you use different kinds of paper, you can lock a tray to prevent printing on
wrong paper such as letterhead or colored paper. When "Auto Select" is selected
in the Paper Source selections from the printer driver, the locked tray will not be
used. You can select each tray set to on or off.

Tray 1, Tray 2, Tray 3, Tray 4

& Note

O Default : Off

Only the installed trays appear on the panel display.
You can lock multiple trays.

If you want to use the locked tray, you must select the tray from the
printer driver.

3 When a locked tray is selected from the printer driver, the printer
does not search for another tray.

aaa

Tray Priority

You can set which tray should be checked first when "Auto tray Select" is select-
ed in the Paper Source selections from the printer driver. When printing from
DOS, the tray selected here is used when no tray is selected for a print job.

Tray 1, Tray 2, Tray 3, Tray 4

& Note
3 Default : Tray 1
3 Only the installed trays appear on the panel display.

3 Itisrecommended that you load paper of the size and direction you
most frequently use in the tray selected with "Tray Priority".
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Changing the Paper Input Menu

Tray Locking

l] Press [Menu).

o] ._ [¢}

Job Reset Form Feed #E nter

@ ErrLIor Dg In O v
| I —

ZDJS001N

"Menu" appears on the panel display.

ﬂ Press [A) or [ V] to display '"Paper Input'", and then press [Enter]).
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B Press [A]) or [ V] to display ""Tray Locking'', and then press [ Enter].

& Note
O Bypass Tray would not be locked.

B Press [A]) or [ V] to display "Off", and then press [ Enter].

Wait for two seconds.
"Menu" appears on the panel display.

B Press [On Line).
"Ready " appears on the panel display.
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Tray Priority

n Press [Menu).

POUSH _ [o}

Job Reset Form Feed #Enter
Error Data In O v
4 ©

ZDJS001N

"Menu" appears on the panel display.

ﬂ Press [A] or [ V] to display '"Paper Input", and then press [ Enter].

ﬂ Press [A] or [ V] to select the tray type you want to use.
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B Press [ Enter]). Wait for two seconds.
"Menu" appears on the panel display.

E Press [On Line).

ZDJS022N

"Ready " message appears on the panel display.
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List/Test Print Menu

There are 6 menu items in the "List/Test Print" menu.
* Config. Page

e Menu List

* Color Demo Page

* PS Config. Page

* PCL Config.Page

* Hex Dump

List/Test Print Parameters

Menu Description

Config. Page You can print the current configuration of the printer. See p.81 “Printing a Con-
figuration Page”.

Menu List You can print the Menu List which shows the function menus of this printer.
Color Demo Page You can print the Color Demo Page.

PS Config. Page You can print a list of the installed PS Fonts.

PCL Config.Page You can print the current configuration of the PCL.

Hex Dump You can print the Hex Dump.
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Printing a Configuration Page

~ Reference
3 For more information, see p.84 “Interpreting the Configuration Page”.

n Press [Menu).

POUEH _ [o}

Job Reset Form Feed #Emer

%er En:r Dz;s In O v
T T ™

"Menu" appears on the panel display.

ﬂ Press [ V] or [A] to display '"'List/Test Print'" menu.




Administrator Reference 2

B Press [ Enter].

FOnline  Menu

m

scape

Ent
Error Data In Q

Power
) 4 °
T T

3+

Job Reset Form Feed

3

A
v

ZDJS021N

The following message appears on the panel display.

ﬂ Press [Enter].
The following message appears on the panel display.

In a short time, the printing a configuration page will start.

1¥Important
3 If you cannot complete printing a configuration page correctly, make sure an error message ap-
pears on the panel display. For more information about error messages, see "Troubleshooting"

in Maintenance Guide 2. '
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B Press [On Line).

ZDJS022N

"Ready " message appears on the panel display.
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Interpreting the Configuration Page

System Reference

#% Printer ID
Shows the serial number assigned to the board by its manufacturer.

% Firmware Version
Shows the version number of the printer controller firmware.

< Engine Version
Shows the version number of the printer engine.

+ Pages Printed
Shows the total number of pages printed by the printer to date.

< NCS Version
Shows the version number of the Network Interface Board.

< Total Memory
Shows the total amount of memory (SDRAM) installed on the printer.

« Printer Language
Shows the version number of the printer language.

+% Printer Hard Disk Drive
Shows "Installed" when the Printer Hard Desk Drive is installed properly.
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< |IEEE 1394
Shows "Installed" when the IEEE 1394 Interface Unit Type 1045 is installed properly.

< Accounting Module
Shows "Installed" when the User Account Enhance Unit TypeB is installed properly.

< Options
Shows the options that you installed.

Paper Input

Shows the settings made under the "Paper Input" menu.

A Reference
3 For more information, see p.73 “Paper Input Menu”.

System

Shows the settings made under the "System" menu.

X Reference
3 For more information, see p.93 “System Menu”.

PCL Menu

Shows the settings made under the "PCL Menu".

~ Reference
3 For more information, see p.109 “PCL Menu”.
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Host Interface

Shows the settings made under the "Host Interface”" menu.

When DHCEP is active on the network, the actual IP Address, Subnet Mask and Gateway Address ap-
pear in parentheses on the configuration page.

X Reference
3 For more information about "Host Interface" menu, see p.102 “Host Interface Menu”.

Error Log

Shows the log of printer errors.
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Maintenance Menu

There are 5 menu items in the "Maintenance" menu.

Color Regist.
Image Density
Registration
HDD Format
Menu Protect

& Note

3 This "HDD Format" appears only when the Hard Disk Drive is installed. For more information,
see "Installing the Printer Hard Disk Type 3800C" in the Setup Guide.
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Maintenance Menu Parameters

Menu Description
Color Regist. You can adjust the color alignment for each color (CMYK)
-7to +7
Image Density You can select the print image density.
3to43
Registration < Prt. Test Sheet

You can print the registration test sheet.
Tray 3, Tray 4, Duplex.Backside

& Note
3 Only the installed trays appear on the panel display.

< Adjustment
You can select the start position for printing on page.
Vert.:Tray 3, Vert.:Tray 4, Vert.:Dup.Bak
-4 to +4 (by 0.5 mm)

& Note
O The registration value are not default.

3 Only the installed trays appear on the panel display.
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Menu

Description

HDD Format

You can format the Hard Disk Drive.
Available when the Hard Disk Drive is installed.

~ Reference

3 For more information about formatting the Hard Disk Drive, see "In-
stalling the Hard Disk Type 3800C" in the Setup Guide.

Menu Protect

This procedure lets you protect menu settings against accidental changes. It
makes it impossible to change the menu settings you make with the normal pro-
cedure unless you perform the required key operation. In a network environment,
protecting settings restricts changes to menu settings to network administrators.
e Levell

e Level2

*  Off

& Note

O While the printer is Online, press [Enter], and then press [Escape],
finally press [Menu]. You can access the "Menu Protect" menu on
the panel display.

3 You can protect the "Maintenance", "System", "Host Interface" and
"Language" menu on Level 1.

3 You can protect the "Paper Input", "Maintenance", "System", "Host
Interface" and "Language" menu on Level 2.
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Changing the Maintenance Menu

Protecting the menus

n Check if the On Line indicator is on. If not, press [On Line] to enter the ""Ready " condition.

B Press [ Enter], then [Escape}, and then [Menu].

F>0OnLine | Menu Escape
0|0 Sla
#enter
O

Job Reset Form Feed
O|wv

Power Error Data In
4 <

@
T T ™

ZDJS025N

"Menu" appears on the panel display.

B Press [A]) or [ V] to display the ""Maintenance' menu, and then press [ Enter].
The following message appears on the panel display.
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ﬂ Press [A]) or [ V] to display '""Menu Protect''.

B Press [Enter].
The following message appears on the panel display.

B Press [A ) or [ V] to select the levels desired, and then press [ Enter). Wait for two seconds.
"Menu" appears on the panel display.

ﬂ Press [On Line).

Job Reset Form Feed H#enter
Power Error Data In o v
[2) 4 ©

ZDJS022N
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"Ready " message appears on the panel display.

Removing Protect

n Check if the On Line indicator is on. If not, press [On Line] to enter the '"Ready " condition.

B Press [ Enter]), then [Escape}, and then [Menu].
"Menu" appears on the panel display.

B Press [A] or [ V] to display '"Maintenance'' menu, and then press [ Enter]).
The following message appears on the panel display.

ﬂ Press [A] or [ V] to display the '""Menu Protect', and then press [ Enter).

B Press [A) or [ V] to display "Off'", and then press [ Enter]. Wait for two seconds.
"Menu" appears on the panel display.

E Press [On Line).
"Ready " message appears on the panel display.
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System Menu

There are 14 menu items in the "System" menu.
* MisfeedRecovery
* Prt. Err Report

* Auto Continue

*  Memory Overflow
* Sub Paper Size

* Page Size

* Duplex

*  Output Tray

* Job Separation

* Energy Saver 1

* Energy Saver 2

* B&W Page Detect
* Unit of Measure

* Resolution
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System Parameters

Menu Description

MisfeedRecovery You can select whether Misfeed Recovery is enabled. When it is on, printing re-
starts after the misfed paper has been cleared.
¢ On
e Off
& Note
O Default: On

Prt. Err Report You can select whether or not to have a error report printed when a printer error

Oor memory error occurs.

¢ On
o Off
& Note

O Default: Off
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Menu

Description

Auto Continue

You can set whether Auto Continue is enabled. When it is on, printing continues
after a system error occurs.

e Off

¢ (O minute

¢ 1 minute

* 5 minutes
¢ 10 minutes

¢ 15 minutes

& Note
O Default: Off

Memory Overflow

You can select whether the memory overflow error report should be printed.
¢ Not Print
¢ Error Report

& Note
O Default: Not Print

Sub Paper Size

You can enable the Sub Paper Size feature. When you select "Auto", the printer
substitutes the paper of a certain size which is to be an alternative if the paper cur-
rently specified is not loaded. When you select "Off", the printer uses the paper
in the current specified paper input tray regardless of its size.

¢ Auto
o Off
& Note

O Default: Auto
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Menu Description

Page Size You can specify the default paper size.
11x17,81/2x14,11x81/2,81/2x11,51/2x81/2,7 1/4x 10 1/2,10 1/2 x
71/4,8x 13,8 1/2x 13,8 1/4 x 13, A3 (297x420), B4 JIS(257x364), A4 (297 x
210), A4 (210 x 297), B5 JIS(257x182), BS JIS(182x257), AS (210 x 148), A5
(148 x 210), A6 (105 x 148), 8K (267x390), 16K (195 x 267), 16K (267 x 195),
41/8x91/2,37/8 x7 1/2, C5 Env (162x229), C6 Env (114x162), DL Env
(110x220), Custom Size
& Note
O Default: Auto

Duplex You can select whether you want to print on both sides of each page.
e Off
e Short Edge Bind
¢ Long Edge Bind
& Note
3 Default: Off
O This menu appears only when the optional Duplex Unit is installed.

Output Tray You can select the default output tray. When you select "Auto Tray SW", the

printer automatically changes to another output tray if the output tray become
full. This function is available only when the Mailbox is installed.

Standard Tray, External Tray, Mailbox Tray 2, Mailbox Tray 3, Finisher Tray 1,
Finisher Tray 2, Auto Tray SW

& Note
O Default: Standard Tray
3 Only the installed trays appear on the panel display.
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Menu

Description

Job Separation

You can enable Job Separation.
*  Off
¢ On

& Note
O Default: Off

3 This menu appears only when the optional 2 Tray Finisher is in-
stalled.

Energy Saver 1

You can set On/Off for the Energy Save Mode level 1. This is preheat mode.
¢ On
e Off

& Note
O Default: On

3 When the printer switches to Energy Saver mode, the Power indi-
cator turns off, while the On Line indicator stays on.

Energy Saver 2

You can set how many minutes the printer wait before switching to Energy Saver
mode. Energy Saver mode reduces electric power consumption.
e On
5 minutes, 15 minutes, 30 minutes, 45 minutes, 60 minutes.
e Off

& Note
3 Default: On (60 minutes)

3 When the printer switches to Energy Saver mode, the Power indi-
cator turns off, while the Online indicator stays on and "Energy
Save Mode " is displayed on the panel display.
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Menu

Description

B&W Page Detect

You can specify whether the Black & White Page Detect feature is enabled.

Even if color is specified for the printer driver Color Mode, every page will be
printed in Black and White Mode if the print job is black and white. In this case,
the consumables needed in the Color Mode will not be used.

¢ On
e Off

& Note
O Default: On

3 If the print job contains a color page, the remaining pages will be
printed in Color Mode even if some or all of them are black and
white.

3 Ifthe first page of the print job is color and the remaining pages are
black and white, the whole print job will be printed in Color Mode.

3 Depending on the kind of data, the print job may not be done prop-
erly even if the function is specified.

Unit of Measure

You can select "mm" or "inch" for the custom paper size.

Resolution

You can set the print resolution in dots per inch.

<% PCL
300 x 300 dpi, 600 x 600 dpi

& PS
600 x 600 dpi, 1200 x 600 dpi, 1200 x 1200 dpi

& Note
O Default: PCL 600 x 600 dpi, PS 600 x 600 dpi
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Changing the System Menu

The following examples changing the settings for "Energy Saver 2".

l] Press [Menu).

Ponuns w _ [¢}

Job Reset Form Feed #Emer

Err':r Dz; In O v
| S N E—

ZDJS001N

"Menu" appears on the panel display.

ﬂ Press [A]) or [ V] to display "System''.
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B Press [ Enter].

FOnline  Menu

m

scape

Ent
Error Data In Q

Power
) 4 °
T T

3+

Job Reset Form Feed

3

A
v

ZDJS021N

The following message appears on the panel display.

ﬂ Press [A] or [ V] to display ""Energy Saver 2", and press [ Enter].

B Press [A]) or [ V] to display "E. Saver2 Timer", and press [ Enter].
The following message appears on the panel display.
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B Press [A] or [ V] to select how many minutes the printer waits before switching to Energy
Saver mode.

The following message appears on the panel display.

ﬂ Press [ Enter). Wait for two seconds.
"Menu" appears on the panel display.

B Press [On Line).

ﬂ o} _ [}

Job Reset Form Feed #Emsr
Error Data In o v
4 <

ZDJS022N

"Ready " message appears on the panel display.
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Host Interface Menu

There are 3 menu items in the "Host Interface" menu.
¢ /O Buffer

e I/O Timeout

* Network Setup

& Note

O The "Network Setup" appears only when the optional Network Interface Board is installed. For more
information about the "Network Setup", see "Configuring the power for the Network with the Oper-
ation Panel' in the Setup Guide.

Host Interface Parameters

Menu Description
1/0 Buffer You can set the size of the I/O Buffer. Normally it is not necessary to change this
setting.
128 KB, 256 KB, 512 KB
& Note
O Default: 128 KB
1/0 Timeout You can set how many seconds the printer should wait before ending a print job.

If data from other port often appears in the middle of the print job, you should
increase the timeout value.

10 seconds, 15 seconds, 20 seconds, 25 seconds, 60 seconds

& Note
O Default: 15 seconds
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Menu

Description

Network Setup

« IP Address
You can set the IP Address.

& Note
O Default: All zero

R Reference

3 See "Configuring the Printer for the Network with the Operation
Panel" in the Setup Guide.

< Subnet Mask
You can set the Subnet Mask.

& Note
O Default: All zero

R Reference

O See "Configuring the Printer for the Network with the Operation
Panel" in the Setup Guide.

< Gateway Address
You can set the Gateway Address.

& Note
O Default: All zero

~ Reference

O See "Configuring the Printer for the Network with the Operation
Panel" in the Setup Guide.
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Menu

Description

< Access Control
You can set the Access Control Address.

& Note
O Default: All zero

< Access Mask
You can set the Access Control Mask.

& Note
O Default: All zero

+ Network Boot
You can set how the Network Interface Board acquires TCP/IP settings.

& Note
O Default: None

R Reference

O See "Configuring the Printer for the Network with the Operation
Panel" in Administrator Reference 1.

< Frame Type (NW)

You can set the Frame Type for NetWare.

& Note
O Default: Auto
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Menu

Description

< Active Protocol
You can set the active protocol.
TCP/1P, NetWare, NetBEUI, AppleTalk

& Note
O Default: All Active

« Ethernet
You can select the speed of the network that the printer is connected to.
Auto, 10 Mbps, 100 Mbps

& Note
O Default: Auto

R Reference

3 See "Configuring the Printer for the Network with the Operation
Panel" in Administrator Reference 1.
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Changing the Host Interface Menu

The following example describes changing the setting for "I/O Timeout".

l] Press [Menu).

Ponuns w _ [¢}

Job Reset Form Feed #Enter

Error Data In
4 b v
| S N E—

ZDJS001N

"Menu" appears on the panel display.

ﬂ Press [A ) or [ V] to display the ""Host Interface' menu.
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B Press [Enter].

S 6 _ [e) A
Job Reset Form Feed #enter
Power Error Data In Q v
4 ©

@
T T ™

ZDJS021N

The following message appears on the panel display.

ﬂ Press [A]) or [ V] to display "'I/O Timeout"'.

B Press [Enter].
The following message appears on the panel display.
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B Press [A) or [ V] to select how many minutes the printer waits before ending a print job.

ﬂ Press [ Enter). Wait for two seconds.
"Menu" appears on the panel display.

B Press [On Line).

ZDJS022N

"Ready " message appears on the panel display.
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PCL Menu

There are 7 menu items in the "PCL Menu".
* Orientation

e Form Lines

¢ Font Source

¢ Font Number

* Point Size

¢ Font Pitch

* Symbol Set

PCL Parameters

Menu Description

Orientation You can set the page orientation.
e Portrait

¢ Landscape

& Note
O Default: Portrait

Form Lines You can set the number of lines per page.
5-128

& Note
O Default: 64 (Metric version), 60 (Inch version)
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Menu

Description

Font Source

You can set the location of the default font.
¢ Resident

« RAM

e HDD

& Note
O Default: Resident

O When you select "RAM", you can select only fonts downloaded to
printer RAM.

Font Number

You can set the ID of the default font you want to use.
¢ 0to 50 (for Internal)

¢ 1 to n (for Download source)

& Note
O Default: Internal
O Default: 0

Point Size

You can set the point size you want to use for the default font.
4 t0 999.75 by 0.25

& Note
O Default: 12.00
O This setting is effective only for a variable-space (proportional) font.
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Menu

Description

Font Pitch

You can set the number of characters per inch you want to use for the default font.
0.44 t0 99.99 by 0.01

& Note
O Default: 10.00
O This setting is effective only for a fixed-space (monospace) font.

Symbol Set

You can specify the set of print characters for the default font. The available op-
tions are as follows.

Roman-8, ISO L1, ISO L2, ISO LS, PC-8, PC-8 D/N, PC-850, PC-852, PC8-TK,
Win L1, Win L2, Win LS5, Desktop, PS Text, VN Intl, VN US, MS Publ, Math-

8, PS Math, VN Math, Pifont, Legal, ISO 4, ISO 6, ISO 11, ISO 15, ISO 17, ISO
21, 1SO 60, ISO 69, Win 3.0

& Note
O Default: Roman-8
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Changing the PCL Menu

The following example describes changing the setting for "Orientation".

l] Press [Menu).

ZDJS001N

"Menu" appears on the panel display.
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ﬂ Press [A) or [ V] to display '""PCL Menu'', and then press [ Enter].

FOnline  Menu

m

scape

Ent

%er En'.\l)r Dz; In Q

3+

Job Reset Form Feed

3

A
v

ZDJS021N

The following message appears on the panel display.

B Press [Enter].

ﬂ Press [A] or [ V] to select the orientation desired, and then press [Enter). Wait for two sec-
onds.

"Menu" appears on the panel display.

g
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B Press [On Line).

ZDJS022N

"Ready " message appears on the panel display.
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Language Menu

You can select the language you use. Available language are as follows.

English, French, German, Italian, Spanish, Dutch, Swedish, Norwegian, Danish, Finnish, Portuguese,
Czech, Polish and Hungarian.

& Note
3 Default: English

Changing the Language Menu

You can change the language by the following procedures below.

n Press [Menu).

POHUEH _ [o}

Job Reset Form Feed #Sr
Error Data In v
4 ©
T /T

ZDJS001N

"Menu" appears on the panel display.
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ﬂ Press [A]) or [ V] to display ""Language".

B Press [Enter].

honu"e o} _ [0}

Job Reset Form Feed #Enlev

@ Power Erv':r Dz;ln Q v
T T ™

ZDJS021N

The following message appears on the panel display.

ﬂ Press [A ) or [ V] until the language you want to select appears on the panel display.

B Press [ Enter). Wait for two seconds.
"Menu" appears on the panel display.
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B Press [On Line).

ZDJS022N

"Ready " message appears on the panel display.
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6. Appendix

Configuring the Printer using SmartNetMonitor for
Admin

Using SmartNetMonitor for Admin, you can not only monitor the status of network printers but also
allows you to change the configurations of the network interface board using the TCP/IP protocol or

IPX/SPX protocol.
0S Protocol Stack
Microsoft Windows 95/98/Me TCP/IP provided with Windows 95/98/Me

IPX/SPX provided with Windows 95/98/Me
NetWare network client provided with Windows 95/98
Novell Client for Windows 95/98

Microsoft Windows 2000 TCP/IP provided with Windows 2000
IPX/SPX provided with Windows 2000
NetWare Client provided with Windows 2000
Novell Client for Windows NT/2000

Microsoft Windows NT4.0 TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT

Client Service for NetWare provided with Windows NT
Novell Client for Windows NT/2000

The following describes the method of changing the network interface board configuration.
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Changing the Network Interface Board Configuration

n Run SmartNetMonitor for Admin.

B Click the [Group] menu, point to [Open LAN], and select [TCP/IP] or [IPX/SPX]. A list of printers
appears.

& Note
3 Select the protocol of the printer you want to change the configure.

B On the list, click to select the printer you want to change the configure.

ﬂ From the [Tools] menu, select [NIB Setup Tool].
The NIB Setup Tool starts up.

B Select [Wizard] or [Property Sheet], and then click [Next].
*  When configuring the network interface board for the first time, select [Wizard].

*  When changing the configuration of the network interface board or configuring it in detail, select
[Property Sheet].

Selecting [Wizard]

@ Fill in the necessary items, and then click [Next].

Selecting [Property Sheet]

@ A configuration list appears on the dialog box.
For more information about each item on the dialog box, see the Help file.
| //
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Locking the Menus on the Printer's Operating Panel

n Run SmartNetMonitor for Admin.

B Click the [Group] menu, point to [Open LAN], and then select [TCP/IP] or [IPX/SPX].
A list of printer appears.

& Note
O Select the protocol of the printer you want to change the configuration.

B Click to select the desired printer.

ﬂ From the [Tools] menu, select [Lock Menu of Device Option Panel].

The Web browser starts up, and the screen that prompts you to type the user name and a password
appears.

B Type the user name and password, and then click [OK].
The general configuration window appears.

E From the [Lock Menu of Device Option Panel] pull down menu, select [Apply].
ﬂ Click [Refresh].
B Exit the Web browser.
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Changing the Paper Type

n Run SmartNetMonitor for Admin.

B Click the [Group] menu, point to [Open LAN], and select [TCP/IP] or [IPX/SPX].
A list of printer appears.

& Note
O Select the protocol of the printer you want to change the configuration.

B On the list, click to select the printer whose paper type you want to change.

ﬂ From the [Tools] menu, select [Paper Type Settings].

The Web browser starts up, and the screen that prompts you to type the user name and a password
appears.

B Type the user name and a password, and then click [OK].
The paper type configuration window appears.

E Select the sheet type, and then click [Apply].
ﬂ Exit the Web browser.
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Managing the Number of Copies to be Printed

] Preparation

3 Optional User Account Enhance Unit TypeB must be installed to manage the number of copies to
be printed. For more information about installing User Account Enhance Unit TypeB, see "Installing
the User Account Enhance Unit TypeB" in the Setup Guide.

n Run SmartNetMonitor for Admin.

ﬂ Click the [Group] menu, point to [Open LAN], and then select [TCP/IP] or [IPX/SPX].
A list of printer appears.

& Note
3 Select the protocol of the printer you want to change the configuration.

B On the list, click to select the printer whose statistics information you want to manage.

ﬂ From the [Tools] menu, select [User Management Tool].
The screen that prompts you to type a password appears.

B Type a password, and then click [OK].

& Note
3 The factory default password is "password".

The User Code Maintenance Tool starts up.

For more information about using the User Management Tool, see the Help file for SmartNetMon-
itor for Admin.
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Configuring the Energy Save Mode

n Run SmartNetMonitor for Admin.
ﬂ Click the [Group] menu, point to [Open LAN], and select [TCP/IP] or [IPX/SPX].

A list of printer appears.

& Note
O Select the protocol of the printer you want to change the configuration.

B Click [Group], point to [Energy Save Mode], and select any energy saver mode from the menu
that appears.
For more information about settings, see the Help file for SmartNetMonitor for Admin.
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Configuring the Network Interface Board with a Web
Browser

The Network Interface Board functions as a Web server in addition to allowing a printer to function as
a network printer. You can use a Web Browser to view the printer status and configure the Network
Interface Board.

< Configuring the printer
This requires the TCP/IP protocol to be installed. After the printer has been configured to use the
TCP/IP protocol, it will be possible to adjust the settings using a Web Browser.

A Reference
O For more information about configuring the printer to use the TCP/IP protocol, see Printer Client
Reference 1 that comes with this printer.

% Operating system browser requirements

(O] Browser
Windows 95/98/Me
Windows 2000
Windows NT 4.0
Mac OS 7.6.1 ~ 9.0
Solaris 2.5 ~ 8

Microsoft Internet Explorer 3.02/4.0 or later

Netscape Navigator 3.0/4.0 or later
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Limitation

Sometimes after clicking [Back] , the previous page may not appear. In this case, click [Refresh]
or [Reload] .

3 The text on the screen may disappear or be aligned incorrectly if the font size settings of the
browser are too large. It is recommended that you use a font size equal to or smaller than "10
point" with Netscape Navigator, and "Medium" or smaller with Internet Explorer.

Going to the Top Page

After launching the Web Browser, type the IP address of the printer. See the example below. This ex-
ample is for the English version.

http://192.168.15.16/
(In this example, the IP address of the Network Interface Board is 192.168.15.16.)

& Note

O If a DNS server is used on the network, you can type the host name as an URL. For example, ht-
tp://webmonitor.netprinter.com/. In order to do this, you must the register the IP address and host
name of the Network Interface Board with the DNS server. Consult the network administrator for in-
formation about how to do this.

3 If the network uses proxy servers, the browser may run slowly.
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3 vt

Bricntam Nl Printer
:Fifth Floor
Stansn of Prisiee 1 Iig:.'nl)

1. Header Buttons

You can register favorite URLs with [URL]. To
view the Help section, click [Help].

{¥Important

O It costs to use the browser to access a web-
site.

& Note

3 The Help file is stored in the following folder
on the CD-ROM in HTML format. The third
folder, "(Language)" may be substituted by
an appropriate language name.

\HELP \WSMHLP\ (Language) \

2. Menu Buttons

Buttons to configure the Network Interface Board
and confirm the status of the printer.

& Note

O When you click [Network Config], a dialog
box appears requesting the user name and
password. Type only the password in this
dialog box. The factory default password is
"password".

O The password is the same as that used for
remote maintenance and that used in the
NIB Setup Tool. If you change a password
with the Web Browser, the other passwords
are also changed.

3. Status

Displays the name and comments of the Network
Interface Board, and the printer status.




Administrator Reference 2

’Q"Linking the address (URL) to the [Help] button

You can link the address (URL) of the [Help] button to the Help files on the computer or on a Web serv-

er.

@ Copy the Help files on the CD-ROM to the desired location. The Help files are located in folders
labeled with abbreviated language names. For example, English Help files are in the [EN] folder. Be
sure to copy the entire [EN] folder to the new location.

@ Using a Web Browser, navigate to the Top Page and click [Network config].
® Type your password, (it is not necessary to type a user name) and click [OK].
@ Type the path to the Help files in the [Help URL] box.
If you copied the Help files to "C:\HELP\EN", type "file://C:/HELP/". For example if you copied

the files to a web server and the index URL is "http://a.b.c.d/HELP/EN/index.html", type "ht-
tp://a.b.c.d/HELP/".

® Click [Apply].

When a warning message appears, select to continue configuration.
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SNMP

The Network Interface Board functions as a SNMP (Simple Network Management Protocol) agent us-
ing the UDP and IPX protocols. Using the SNMP manager you can get information about the printer.
The factory default community names are "public”" and "admin". You can get MIB information using
these community names.

~ Reference
3 For more information about configuring the community name, see p.138 “SNMP” in "Remote Main-
tenance by telnet".

Limitation

| 4
3 The kinds of supported MIBs differ depending on the printer.

¢

< Supported MIBs

e MIB-II

¢ PrinterMIB

* HostResourceMIB
* RicohPrivateMIB
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Remote Maintenance by telnet

You can view the printer status and configure the Network Interface Board using telnet.

& Note
3 You should specify a password so that only the network administrator, or a person having network
administrator privileges, can use remote maintenance.

Using telnet

The following is a sample procedure in using telnet.

? Limitation
O Only one person at a time can be logged on to do remote maintenance.

n Using the IP address or host name of the printer, start telnet.
% telnet IP_address

& Note
3 In order to use the host name instead of the IP address, you must write it to the /etc/hosts file.

ﬂ Type the password.

& Note
3 The factory default is "password".

B Type a command.

~ Reference
3 For more information about telnet commands, see p.130 “Commands List”.

g
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ﬂ Exit telnet.
msh> logout

When the configuration is changed, a confirmation message requests whether or not the changes
should be saved.

B Type "yes'" to save the changes, and press [ENTER].

If you do not want to save the changes, type "no" and press [ENTER]. If you want to make additional
changes, type "return" at the command line, and press [ENTER].

& Note
3 Ifthe "Can not write NVRAM information" message appears, the changes are not saved. Repeat
the steps above.

3 The Network Interface Board is reset automatically when the settings are changed.

3 When the Network Interface Board is reset, the active print job which has already been sent to
the printer will finish printing. However, jobs that have not been sent yet will be canceled.

Commands List

This is a list of commands that can be used via remote maintenance.

& Note
O Type "help" to see a list of commands that can be used.

msh> help
O Type "help command_name" to display information about the syntax of that command.
msh> help command_name
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TCP/IP address

Use the ifconfig command to configure TCP/IP for the printer (IP address, subnet mask, broadcast ad-
dress, default gateway address).

< Reference
msh> ifconfig

% Configuration
msh> ifconfig naf0 parameter address

Parameter Meaning

(no parameter) IP address

netmask subnet mask

gateway default gateway address
broadcast broadcast address

The following is an example for configuring an IP address of 192.168.15.16.
msh> jifconfig naf0 192.168.15.16

The following is an example for configuring a subnet mask of 255.255.255.0.
msh> ifconfig naf0 netmask 255.255.255.0

& Note
O This affects the configuration of the Network Interface Board of the IP address that is used.
3 To type an address using hexadecimal, prefix it by "0x".
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‘Q”‘Address
< Subnet Mask

A number used to mathematically "mask" or hide the IP address on the network by eliminating those
parts of the address that are alike for all the machines on the network.

% Default Gateway Address
A gateway is a connection or interchange point that connects two networks. A gateway address is
for the router or host computer used as a gateway.

& Note
3 To get the above addresses, contact your network administrator.

Access Control

Use the access command to view and configure access control.

< Reference
msh> access

< Configuration
msh> access parameter address

Parameter Meaning

control Access Control Address

mask Access Control Mask
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& Note

O The Access Control Address and the Access Control Mask are used to limit access to the computer
used for printing by denying access to users based on their IP address. If it is not necessary to limit
access, set the Access Control Mask to "0.0.0.0".

3 When the Access Control Address matches the masked result of the IP address computer attempt-
ing to print, print jobs from that IP address will be accepted by the Network Interface Board.

O For example, if you assign 192.168.15.16 as the Access Control Address of the Network Interface
Board, the IP addresses that can print are as follows. XXX means any number from 1 to 254 is ac-
ceptable.

Access Control Mask IP addresses that can access the
printer
0. 0. 0. O XXX . XXX . XXX . XXX
255. 0. 0. O 192 . XXX . XXX .XXX
255.255. 0. O 192.168.XXX.XXX
255.255.255. O 192.168. 15.XXX
255.255.255.255 192.168. 15. 16
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Network Boot

Use the set command to configure the boot method.

msh> set parameter {on | off}

"on" means active and "off" means inactive.

Parameter Meaning
dhcp DHCP (Dynamic Host Configuration Pro-
tocol)
& Note

O When you use DHCP, the server also needs to be configured.
O DHCP takes precedence over all other settings.
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Protocol

Use the set command to allow/prevent remote access for each protocol.
msh> set protocol {up | down}

Protocol

appletalk "up" means active and "down" means inac-
tepip tive.

netware
netbeui
Ipr

ftp

rsh
diprint
web

snmp

ipp

& Note

3 If you prohibit remote access using TCP/IP and then log out, you cannot use remote access. If this
was a mistake, you can use the printer operation panel to allow access by TCP/IP.

3 When you prevent access via TCP/IP, you are also prevented from using lpr, ftp, rsh, diprint, web,
snmp and ipp.

W
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Printer status

The following commands can be used to get information about the current status of the printer.
msh> command

Command Information that is displayed

status Status of printer.

Information about the print jobs.

info Information about the paper tray, output tray,
printer language of printer.

prnlog [ID] Lists the last 16 print jobs.
& Note
3 More information about any print job is displayed when the ID number is added after the prnlog com-
mand.
~ Reference

3 For more information about the meaning of the data returned with these commands, see p.130
“Commands List”.
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Network Interface Board configuration settings information

Use the show command to display the Network Interface Board configuration settings.
msh> show [-p]

& Note
3 Add "-p" to the show command to have the information displayed one screen at a time.

X Reference
3 For more information about the meaning of the data returned with this command, see p.130 “Com-
mands List”.

System log information

Use the syslog command to display information stored in the printer's system log.

msh> syslog

£ Reference
3 For more information about the displayed information, see p.130 “Commands List”.
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SNMP

Use the snmp command to display and edit SNMP configuration settings such as the community name.

& Note
3 You can configure from ten SNMP access settings numbered 1-10.

3 Default access settings 1 and 2 are as follows.

Number 1 2
Community name public admin
IP address 0.0.0.0 0.0.0.0
Access type read-only read-write
trap off trap off
< Display

Shows the SNMP information and available protocols.

msh> snmp °?

msh> snmp [-p] [registered_ number]

& Note

3 If the -p option is added, you can view the settings one by one.
3 Omitting the number displays all access settings.

< Community name configuration
You can set the community name of the Network Interface Board.

msh> s number name community_name
Y.

& Note
O The community name must consist of 15 characters or less.
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< Access type configuration
You can select the access type from those listed below.
msh> snmp number type access_type

Access type Type of access which is permitted
read Read only

write Read and write

trap User is notified of trap messages.
no All access is denied.

< Protocol configuration
You should use the following command to set the protocols to active or inactive. If you set a protocol
to inactive, all access settings set to use that protocol are disabled.

msh> snmp {ip | ipx} {on | off}
¢ "on" means active and "off" means inactive

To change the protocol of an access settings, use the following command. However, if you disabled
a protocol with the above command, making it active here will have no effect.

msh> snmp number active {ip | ipx} {on | off}
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% Access configuration
You can configure an address of a host depending on the protocols used.
The Network Interface Board accepts requests only from hosts having addresses with access types
of "read-only" or "read-write". Type "0" to have the Network Interface Board accept requests from
any host without requiring a specific type of access.

Command syntax:
msh> snmp number {ip | ipx} address

& Note

O To specify the TCP/IP protocol, type ip followed by a space and then the IP address.

3 To specify the IPX/SPX protocol, type ipx followed by a space and then the IPX address followed
by a decimal and then the MAC address of the Network Interface Board.

The following is an example of how to configure registration number 3 with the IP address

192.168.15.16.

msh> snmp 3 ip 192.168.15.16

The following is an example of how to configure registration number 3 with the IPX address

7390A448, and the MAC address 00:00:74:62:5C:65.

msh> snmp 3 ipx 7390A448:000074625C65
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IPP

Use the ipp command to configure the IPP settings.

K2
%

¢

Viewing setting
The following command displays the current IPP settings.

msh> ipp
Example output:

timeout=900 (sec)
auth basic

* The "timeout" setting specifies how many seconds the computer keeps trying to access the net-
work printer to send print jobs when no connection could be made.

* The "auth" setting indicates the user authorization mode.

IPP timeout configuration
Specify how many seconds to wait before canceling a print job if it has been interrupted for some
reason. The range of time can be changed between 30 to 65535 seconds.

msh> ipp timeout {30 -65535}

IPP user authorization configuration
Use the IPP user authorization to restrict users that can print with IPP. The factory default is "off" .

msh> ipp auth {basic | digest | off}
* "basic" and "digest" are user authorization setting.

e "off" removes a user's authorization.

& Note

3 If you select "basic" or "digest", see next section "Configuring IPP user authorization" for how to
configure the user name. Up to ten user names are available.
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% Configuring IPP user authorization
Use the following command:

msh> ipp user

The following message appears.

msh> Input user number (1 to 10):
Type the number, user name and password.

msh> IPP user name:userl
msh> IPP password:****%xxx
After configuring the settings, the following message appears.

User configuration changed.

SMB

Use the smb command to configure or delete the computer name or workgroup name for NetBEUI.
msh >smb parameter

Parameter Settings

smb comp Your computer name consisting of up to 13 characters
smb group Workgroup name consisting of up to 15 characters
smb comment Comment consisting of up to 31 characters

smb clear comp Clears complete name

smb clear group Clears Workgroup name

smb clear comment Clears comment
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ROUTE

Use the route command to control the routing table.

This command allows you to configure and display routing information. You can change the network
configuration from remote PC using this command.

& Note

3 The maximum number of routing tables are 16.

Parameter

Topics of setting

route add {host | net} destination
gateway

Adds a host/network route to "destination", and a gateway address to "gateway"
in the table. Host becomes the default setting.

route delete {host | net} destina-
tion

Deletes a host/network route from the table. Host becomes the default setting.

route get {destination }

Displays only route information corresponding to a specified destination. When
the destination is unspecified, all routing information is displayed.

route active {host | net} destina-
tion *! on/off

You can turn the specified destination on or off. Host becomes the default set-
ting.

route flush

Deletes all routing information.

“1 1P address
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SLP

Use this command to configure SLP settings.

You can search the NetWare server using SLP in the PurelP environment of NetWare5. To use the slp
command, you can configure the value of TTL which can be used by SLP multi-cast-packet.

& Note

3 The default value of TTL is "1". A search is executed only within a local segment. If the router does
not support multi-cast, the settings are not available even if the TTL value is increased.

3 The acceptable TTL value is 1 - 255.
msh> slp ttl {1 -255}

Changing the password

Use the passwd command to change the remote maintenance password.

i@klmportant
3 Be sure not to forget or lose the password.

& Note
3 The default factory password is "password".

n Type "passwd"'.
msh> passwd

B Type the current password.
Old password:
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B Type the new password.
New password:

& Note

3 The password must consist of 3 to 8 alphanumeric characters and symbols. Upper and lower
case characters are considered unique. For example, R is different fromr.

3 The password is the same as that used in the configuration of the Network Interface Board using
a Web Browser and that used in the NIB Setup Tool. If you change a password from telnet, the
other passwords are also changed.
ﬂ Type the new password once again.
Retype new password:
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Getting Printer Information over the Network

Printer current status

You can check the printer's status using the telnet command.

% telnet
Use the status command.
Messages Description Comments

Call Service Center There is a malfunction in the printer. | Turn the printer off and on.

Call Service Center: SC***-* An error has occurred in the printer. | First, turn the power switch off and
then on. If the message appears again,
call your sales or service representa-
tive.

Cover Open: Duplex Unit The cover of the optional Duplex Close the cover of the optional Du-

Unit is open. plex Unit.

Cover Open: Front Cover Close the front cover. Close the front cover.

Cover Open: Mailbox The cover of the Mailbox is open. Close the cover of the Mailbox cover.

Empty: Black Toner The toner cartridge is empty. Replace the new toner cartridge.

Empty: Cyan Toner The toner cartridge is empty. Replace the new toner cartridge.

Empty: Magenta Toner The toner cartridge is empty. Replace the new toner cartridge.

Empty: Yellow Toner The toner cartridge is empty. Replace the new toner cartridge.

Energy Saver Mode The printer is in Energy Save Mode. | Wait for a while.
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Messages

Description

Comments

Error

: Command Transmission

An error has occurred in the engine or
controller.

First, turn the power switch off and
then on. If the message appears again,
call your sales or service representa-
tive.

Error: DIMM Value An error has occurred in the DIMM. | First, turn the power switch off and
then on. If the message appears again,
call your sales or service representa-
tive.

Error: Ethernet Board An error has occurred in the Network | First, turn the power switch off and

Interface Board. then on. If the message appears again,
call your sales or service representa-
tive.

Error: HDD Board An error has occurred in the optional | First, turn the power switch off and

Hard Disk Drive. then on. If the message appears again,
call your sales or service representa-
tive.

Error: IEEE 1394 Board An error has occurred in the optional | First, turn the power switch off and

1394 Interface Unit.

then on. If the message appears again,
call your sales or service representa-
tive.

Error: Memory Switch An error has occurred in printer. First, turn the power switch off and
then on. If the message appears again,
call your sales or service representa-
tive.

Error: Optional RAM An error has occurred in the optional | First, turn the power switch off and

Memory Unit.

then on. If the message appears again,
call your sales or service representa-
tive.
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Messages

Description

Comments

Error: Parallel I/F Board

An error has occurred in the parallel
interface board.

First, turn the power switch off and
then on. If the message appears again,
call your sales or service representa-
tive.

Full: Finisher All output trays of the optional Fin- | Remove paper from the Finisher.
isher are full.

Full: Finisher Tray 1 Output tray 1 of the optional Finisher | Remove paper from the Finisher.
is full.

Full: Finisher Tray 2 Output tray 2 of the optional Finisher | Remove paper from the Finisher.
is full.

Full: Hole Punch Receptacle Hole Punch Receptacle of the option- | Remove Hole Punch Receptacle from
al Finisher is full. the Finisher.

Full: Mailbox All output trays of the optional Mail- | Remove paper from the Mailbox.
box are full.

Full: Mailbox Tray 1 The output tray 1 of the optional Remove paper from the output tray 1
Mailbox is full. of the optional Mailbox.

Full: Mailbox Tray 2 The output tray 2 of the optional Remove paper from the output tray 2
Mailbox is full. of the optional Mailbox.

Full: Mailbox Tray 3 The output tray 3 of the optional Remove paper from the output tray 3
Mailbox is full. of the optional Mailbox.

Full: Mailbox Tray 4 The output tray 4 of the optional Remove paper from the output tray 4
Mailbox is full. of the optional Mailbox.

Full: Output Tray(s) All output trays are full. Remove paper from all output trays.

Full: Standard Tray The standard tray is full. Remove paper from standard trays.




Administrator Reference 2

Messages

Description

Comments

Full: Waste Toner

The waste toner is full

Replace a new waste toner.

Hex Dump Mode

The printer is in Hex Dump Mode.

Wait for a while. If the "Hex Dump

Mode" message does not change, on
the panel display press [On Line] to
return to the "Ready " condition.

Low: Black Toner

The toner cartridge is not set correct-
ly or toner is almost running out.

Set the toner cartridge correctly.

Low: Cyan Toner

The toner cartridge is not set correct-
ly or toner is almost running out.

Set the toner cartridge correctly.

Low: Magenta Toner

The toner cartridge is not set correct-
ly or toner is almost running out.

Set the toner cartridge correctly.

Low: Yellow Toner

The toner cartridge is not set correct-
ly or toner is almost running out.

Set the toner cartridge correctly.

Low: Staples

The staple is not set correctly or sta-
ple is almost running out.

Set the staple cartridge correctly.

Malfunction: Duplex Unit

An error has occurred in the optional
Duplex Unit.

First, turn the power switch off and
then on. If the message appears again,
call your sales or service representa-
tive.

Malfunction: Finisher

An error has occurred in the optional
Finisher.

First, turn the power switch off and
then on. If the message appears again,
call your sales or service representa-
tive.

Malfunction: Input Tray(s)

An error has occurred in the Input
Tray(s).

First, turn the power switch off and
then on. If the message appears again,
call your sales or service representa-
tive.
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Messages

Description

Comments

Malfunction:

Output Shift

An error has occurred in the output
tray when use the output shift feature.

First, turn the power switch off and
then on. If the message appears again,
call your sales or service representa-
tive.

Malfunction:

Punch Unit

An error has occurred in the optional
Punch Unit.

First, turn the power switch off and
then on. If the message appears again,
call your sales or service representa-
tive.

Malfunction:

Stapler

An error has occurred in the optional
Staple Unit.

First, turn the power switch off and
then on. If the message appears again,
call your sales or service representa-
tive.

Malfunction:

Tray 1

An error has occurred in the tray 1.

First, turn the power switch off and
then on. If the message appears again,
call your sales or service representa-
tive.

Malfunction:

Tray 2

An error has occurred in the tray 2.

First, turn the power switch off and
then on. If the message appears again,
call your sales or service representa-
tive.

Malfunction:

Tray 3

An error has occurred in the tray 3.

First, turn the power switch off and
then on. If the message appears again,
call your sales or service representa-
tive.

Malfunction:

Upper Tray 4

An error has occurred in the tray 4.

First, turn the power switch off and
then on. If the message appears again,
call your sales or service representa-
tive.
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Messages

Description

Comments

Mismatch: Paper Size

The paper size setting of the tray dif-
fers from that of actual paper size in
the tray.

Load paper of the indicated paper
size into the paper tray being used.
See "Paper and Other Media" in
Maintenance Guide 2.

Mismatch: Paper Size and Type

The paper type setting of the tray dif-
fers from that of actual paper type in
the tray.

Load paper of the indicated paper
size and type into the paper tray being
used. See "Paper and Other Media"
in Maintenance Guide 2.

Mismatch: Paper Type

The paper type setting of the tray dif-
fers from that of actual paper type in
the tray.

Load paper of the indicated paper
type into the paper tray being used.
See "Paper and Other Media" in
Maintenance Guide 2.

Nearly Full: Waste Toner Bottle

The waste toner is full nearly

Replace a new waste toner.

No Paper: Bypass Tray

There is no paper in the bypass tray.

Load paper into the bypass tray. See
Maintenance Guide 2.

No Paper: Input Tray(s)

There is no paper in the paper tray.

Load paper into the paper tray. See
Maintenance Guide 2.

No Paper: Selected Tray

There is no paper in the current tray.

Load paper into the current tray. See
Maintenance Guide 2.

No Paper: Tray 1

There is no paper in the paper tray
(Tray1).

Load paper into the bypass tray.See
Maintenance Guide 2.

No Paper: Tray 2

There is no paper in the optional Pa-
per Feed Unit (Tray2).

Load paper into the bypass tray. See
Maintenance Guide 2.

No Paper: Tray 3

There is no paper in the optional Pa-
per Feed Unit (Tray3).

Load paper into the bypass tray. See
Maintenance Guide 2.
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Messages

Description

Comments

No Paper: Tray 3(LCT)

There is no paper in the optional LCT
(Tray3).

Load paper into the bypass tray. See
Maintenance Guide 2.

No Paper: Tray 4

There is no paper in the optional Pa-
per Feed Unit (Tray4).

Load paper into the bypass tray. See
Maintenance Guide 2.

No Paper: User Selected Tray

There is no paper in the selected tray.

Load paper into the selected tray. See
Setup Guide.

Not Detected: Duplex Unit

The optional Duplex Unit is not set
correctly.

An error has occurred in the Duplex
Unit.

Set the optional Duplex Unit correct-
ly. If the message appears again, call
your sales or service representative.

Not Detected: Fusing Unit

The fusing unit is not set correctly.

Set the fusing unit correctly. If the
message appears again, call your
sales or service representative.

Not Detected: Input Tray(s)

The input tray is not set correctly.

Set the input tray correctly. If the
message appears again, call your
sales or service representative.

Not Detected: Black Toner

The toner cartridge is not set correct-
ly.

Set the toner cartridge correctly. If
the message appears again, call your
sales or service representative.

Not Detected: Cyan Toner

The toner cartridge is not set correct-
ly.

Set the toner cartridge correctly. If
the message appears again, call your
sales or service representative.

Not Detected: Magenta Toner

The toner cartridge is not set correct-
ly.

Set the toner cartridge correctly. If
the message appears again, call your
sales or service representative.
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Messages

Description

Comments

Not Detected: Yellow Toner

The toner cartridge is not set correct-
ly.

Set the toner cartridge correctly. If
the message appears again, call your
sales or service representative.

Not Detected: Tray 1

The paper tray (Tray 1) is not set cor-
rectly.

Set the paper tray (Tray 1) correctly.
If the message appears again, call
your sales or service representative.

Not Detected: Tray 2

The paper tray (Tray 2) is not set cor-
rectly.

Set the paper tray (Tray 2) correctly.
If the message appears again, call
your sales or service representative.

Not Detected: Tray 3

The optional Paper Feed Unit (Tray
3) is not set correctly.

Set the optional Paper Feed Unit
(Tray 3) correctly. If the message ap-
pears again, call your sales or service
representative.

Not Detected: Tray 3(LCT)

The optional LCT (Tray 3) is not set
correctly.

Set the optional LCT (Tray 3) cor-
rectly. If the message appears again,
call your sales or service representa-
tive.

Not Detected: Tray 4

The optional Paper Feed Unit (Tray
4) is not set correctly.

Set the optional Paper Feed Unit
(Tray 4) correctly. If the message ap-
pears again, call your sales or service
representative.

Not Detected: User Selected Tray

The selected tray is not set correctly.

Set the selected tray correctly. If the
message appears again, call your
sales or service representative.

Offline

The printer is Offline.

If you want to change into On Line,
press [On Line).
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Messages

Description

Comments

On Line

Online

The printer is Online.

You can print the job data.

Paper in Finisher

There is paper in the optional Finiser.

Remove the paper. See Maintenance
Guide 2.

Paper Misfeed: Duplex Unit

There is misfeed in the Duplex Unit.

Remove the misfed paper. See Main-
tenance Guide 2.

Paper Misfeed: Front Cover

There is misfeed in the printer.

Remove the misfed paper. See Main-
tenance Guide 2.

Paper Misfeed: Input Tray

There is misfeed in the printer.

Remove the misfed paper. See Main-
tenance Guide 2.

Paper Misfeed: Mailbox

There is misfeed in the Mailbox.

Remove the misfed paper.

Paper Misfeed: Output Tray

There is misfeed in output tray.

Remove the misfed paper.

Printing...

Wait for a while.

Warming Up/Adjusting...

The printer is warming up or toner is
being supplied.

Wait until the panel display change
the "Ready ".
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Printer configuration

You can check the printer configuration using telnet.

« telnet
Use the info command.

& Note

3 ™" (asterisk) is displayed with the current setting.
3 Regarding *1 - *5, see below table.

Item

Description

Input Tray
No.

Name
PaperSize
Status

ID number of the paper tray
Name of the paper tray™!
Paper size loaded in the paper tray”™?

Current status of the paper tray ™

Output Tray
No.

Name
Status

ID number of the output tray
Name of the output tray™*

Current status of the output tray™

Printer Language
No.
Name

Version

ID number of the printer language used by the printer
Name of the printer language used in the printer

Version of the printer language




< *1 Input Tray: Name
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Name

Description

Tray X

Name of installed paper tray. (X is the number of tray.)

Bypass Tray

Bypass Tray

% *2 Input Tray: Paper Size

Paper Size

Description

A3 (297 x 420 mm)

A3 (297 x 420) &

B4JIS (257 x 364 mm)

B4 (257 x 364) @

A4 (297 x 210 mm)

A4 (297 x 210) [J

A4 (210 x 297 mm)

A4 (210 x 297)

BSJIS (257 x 182 mm)

B5 (257 x 182) [J

BSJIS (182 x 257 mm)

B5 (182 x 257) &

A5 (210 x 148 mm)

A5 (210 % 148) [J

A5 (148 x 210 mm)

A5 (148 x210) @

A6 (105 x 148 mm)

A6 (105 x 148) @

11x17 DL (11 x17) @
81/2x 14 LG8 'hx14) D2
11x81/2 LT (11x8'5) [
81/2x 11 LT@®'hx11) 2
512%x81/2 HL (5 ', x 81, 3




Administrator Reference 2

Paper Size Description
Custom(XXXxYYY mm) Custom Size
101/2x7 1/4 10, x71/4 [
71/4%x101/2 7Y% 101, 5
81/4%x13 8lyx130
81/2%x13 81hx 130
41/8x91/2 415x9 1,
3718%x71/2 37sx 71,
DL (110 x 220 mm) DL (110 x 220) &
C5 Env (162 X 229 mm) C5 Env (162 x 229) &
8x 13 8x13 &
C6 Env (114 x 162 mm) C6 Env (114 x 162) &
8K (267 x 390 mm) 8K (267 x 390) @

16K (267 x 195 mm)

16K (267 x 195) [)

16K (195 x 267 mm)

16K (195 x 267) ¥

NCS

There is no tray.

dok

The paper size is not selected.
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< *3 Input Tray: Status

Status Description
Normal —
NoTray There is no paper tray
PaperEnd There is no paper in the paper tray

% *4 Output Tray: Name

Name

Description

Standard Tray

Output Tray

Mailbox Tray 1- 4

Mailbox output tray 1- 4

% *5 Output Tray: Status

Status Description
Normal -—--
PaperExist There is paper in the output tray
OverFlow Output tray is full of paper
Error Other error
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Understanding the Displayed Information

This section describes how to read status information returned by the Network Interface Board.

Print Job Information

The status of the print job can be viewed using the following commands.
* telnet : Use the status command. = p.130 “Commands List”

Item name Meaning
Rank Status of print job.
e Active

Printing or preparing for printing.

e Waiting
Waiting to be transferred to the printer.
Owner Print request user name.
Job Print request number.
Files The name of the document.
Total Size The size of the data (spooled).

Always displayed "0 bytes".
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Print Log Information

This is a record of the most recent ten jobs that have been printed.
This log can be displayed with the following commands.
* telnet : Use the prnlog command. = p.130 “Commands List”

Name Meaning

ID Print request ID.

User Print request user name.

Page The number of pages that is printed.

Time The time when the print request was received

User ID User id that is to be configured in the printer driver.
JobName The name of the document for printing.
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Configuring the Network Interface Board

The Network Interface Board settings can be displayed and confirmed using the commands below.
* telnet : Use the show command. = p.130 “Commands List”

Item name Meaning

Common
Mode
Protocol Up/Down Up means active, Down means inactive.

AppleTalk
TCP/TP
NetWare
NetBEUI
Ethernet interface
NVRAM version Internal version number.

Device name

Comment

Location

Contact

Soft switch

AppleTalk
Mode AppleTalk protocol in selection.

Net Network number.
Object Macintosh printer name.
Type The type of printer.

Zone Name of the zone that the printer belongs to.
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Item name Meaning
TCP/TP
Mode Up means active, Down means inactive.
ftp
Ipr
rsh
diprint
web
telnet
download
snmp
ipp
EncapType Frame type.
Network boot Network boot.
Address IP address.
Netmask Subnet mask.
Broadcast Broadcast address.
Gateway Default gateway address.
AccessCtrl Access control address.
AccessMask Access control mask.
Time server
Home page URL URL of homepage.
Home page link name URL name of homepage.
Help page URL URL of help page.
SNMP protocol Protocol used with SNMP.
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Item name Meaning

NetWare
EncapType Frame type.
RPRINTER number Remote printer number.

Print server name
File server name
Context name
Switch
Mode
NDS/Bindery
Packet negotiation

Print job timeout

Print server name.
Name of the connect file server.

Context of print server.

Active mode.

(this value is fixed)

Time of the job timeout.

NetBEUI

Switch

Mode

Direct print

Notification
Workgroup name
Computer name
Comment

Share name[1]

(this value is fixed)

(this value is fixed)

Notification of print job completion.
Name of the workgroup.

Name of the computer.

Comment.

Share name (name of the printer type).

Shell mode

Mode of remote maintenance tool.
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Message List

This is a list of messages written to the printer's system log. The system log can be viewed using the

syslog command.

System Log Information

You can use the following methods to view the system log.

* telnet : Use the syslog command. = p.130 “Commands List”

Message

Description and Solutions

Access to NetWare server "file server name" denied. Ei-
ther there is no account for this print server on the Net-
Ware server or the password was incorrect.

(In print server mode) Cannot log in to the file server.
Confirm that the print server is registered on the file serv-
er. If a password is specified for the print server, delete it.

add_sess: community<community name> already de-
fined.

The same community name already exists. Use another
community name.

add_sess: session<community name> not defined.

A requested community name is not defined.

add_sess: bad trap addr:<IpAddress>, community:<com-
munity name>

The IP address (0.0.0.0.) is unavailable when the commu-
nity access type is TRAP. Specify the host IP address for
the TRAP destination.

add_sess_ipx: bad trap addr: <IPX address>, communi-
ty:<community name>

The IPX address (00:00:00:00:00:00) is unavailable
when the community access type is TRAP. Specify the
host IPX address for the TRAP destination.

add_sess_ipx: community <community name> already
defined.

The same community name already exists. Use another
community name.

add_sess_ipx: session_ipx<community name> not de-
fined.

A requested community name is not defined.
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Message

Description and Solutions

ANONYMOUS FTP LOGIN FROM <IP address>,
<password>

An anonymous login has been made with a password
<password> from the host <IP address>.

anpd start. (AppleTalk)

An anpd (AppleTalk Network Package Daemon) has
started.

Attach FileServer="file server name"

Attached to the file server as a nearest server.

Attach to print queue "print queue name"

(In print server mode) Attached to the print queue name.

Cannot create service connection

(In remote printer mode) Cannot establish a connection
with the file server. The number of file server users may
exceed the maximum number that the file server can han-
dle.

Cannot find rprinter ("print server name"/"printer num-
ber")

The printer having the number displayed on the print
server does not exist. Confirm the number of the printer
registered to the print server.

Change IP address from DHCP Server.

The IP address changes when DHCP LEASE is renewed.
To always assign the same IP address, set a static IP ad-
dress to the DHCP server.

child process exec error! (process name)

Failed to start the network service. Turn the printer off
and then on. If this does not work, contact your service or
sales representatives.

Connected DHCP Server(<DHCP server address>).

The IP address was successfully received from the DHCP
server.

connection from <IP address>

Logged on from the host <IP address>.

Could not attach to FileServer <error number>

(In remote printer mode) Cannot attach to the file server.
For some reason, the file server refuses the connection.
Check the file server configuration.
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Message

Description and Solutions

Could not attach to PServer <print server>

(Inremote printer mode) Cannot attach to the print server.
For some reason, the print server refuses the connection.
Check the print server configuration.

Current Interface Speed:xxxMbps

The speed of the network (10 Mbps or 100 Mbps).

Current IP address <current IP address>

The IP address <current IP address> was received from
the DHCP server.

Current IPX address The current IPX address.

DHCEP lease time expired. DHCEP lease time has expired. The printer tries to discov-
er the DHCP server again. The IP address used up to now
becomes invalid.

DHCP server not found. The DHCP server cannot be found. Make sure the DHCP
server is running on the network.

dhcped start. A dhcped (DHCP client service) has started.

diprinted started

Direct print service has started.

Duplicate IP=(IP address>(from <MAC address>).

The same IP address is used. An IP address must be
unique. Check the address of the device indicated in The
same IP address is used. An IP address must be unique.
Check the address of the device indicated in <KMAC ad-
dress>.

Established SPX Connection with PServer,(RPSock-
et=(socket number>), connID=<connection ID>

(In remote printer mode) A connection with the print
server has been established.

Exit pserver

(In print server mode) Exits the print server because the
necessary print server settings have not been made.

Frametype="frame type name"

The "frame type name" is configured to be used on Net-
Ware.
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Message Description and Solutions
httpd start. An httpd has started.

inetd start. An inetd has started.

ipp disable. Printing with ipp is disabled.
ipp enable Printing with ipp is enabled.

LeaseTime=<lease time>(sec), RenewTime=<renew
time>(sec).

The resource lease time that was received from the DHCP
server is in seconds. The renewal time is also in seconds.

Login to fileserver "file server name" ("NDS|BIND-
ERY")

(In print server mode) Logged in to the file server with
NDS or BINDERY mode.

multid start.

Data transmission service for multiprotocols has started.

nbstart start. (NetBEUI)

The service for NetWare protocol stack setting has start-
ed.

NBT Registration Broadcast(<NetBIOS name>)

Use a local broadcast to map <NetBIOS name> with the
IP address.

nptd start.

A nbtd (NetBIOS over TCP/IP Daemon) has started.
(Available only in DHCP mode)

NetBEUI Computer Name="computer name"

The NetBEUI Computer Name is defined as "computer
name".

nmsd start. (NetBEUI)

A nmsd (Name Server Daemon) has started.

npriter start. (NetWare)

(In remote printer mode) NetWare service has started in
remote printer mode.

nwstart start. (NetWare)

The service for NetWare protocol stack setting has start-
ed.
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Message

Description and Solutions

Open log file "file name"

(In print server mode) The specified log file has been
opened.

papd start.

AppleTalk print service has started.

phy release file open failed.

Replacing the Network Interface Board is required. Con-
tact your sales or service representatives.

Print queue "print queue name" cannot be serviced by
printer 0, "print server name"

(In print server mode) The print queue name cannot be
serviced. Make sure that print queue volume exists on the
specified file server.

Print server <print server name> has no printer.

(In print server mode) The printer object is not assigned
to the print server <print server name>. Using NWAd-
min, assign the printer object, and then restart the printer
device.

Print session full

Cannot accept the print session.

Printer "printer name" has no queue

(In print server mode) The print queue is not assigned to
the printer. Using NWAdmin, assign the print queue to
the printer, and then restart it.

pserver start. (NetWare)

(In print server mode) NetWare service has started.

Required computer name (<Computer name>) is dupli-
cated name

The same computer name is detected on the network. The
start job determines the computer name by adding the
computer name to the suffix (0,1....). Configure a new
computer name that is unique.

Required file server ("file server name") not found

Cannot find the required file server.

restarted.

LPD has started.
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Message

Description and Solutions

sap enable, saptype=<SAP type>, sapname=<sap name>

The SAP function has started. The SAP (SAP type and
SAP name) packet is issued to advertise the service on the
SAP table on the NetWare server.

Set context to <NDS context name>

A <NDS context name> has been set.

shutdown signal received. network service rebooting...

Rebooting the network service.

smbd start. (NetBEUI)

An smbd (SMB (Server Message Block) service) has
started.

Snmp over ip is ready.

Communication over TCP/IP with SNMP is available.

Snmp over ipx is ready.

Communication over IPX with SNMP is available.

snmpd start.

SNMP service has started.

The print server received error "error number" during at-
tempt to log in to the network.Access to the network was
denied. Verify that the print server name and password are
correct.

Cannot log in to the file server. The print server is not reg-
istered or the password is specified. Register the print
server without specifying a password.
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Precautions

Please pay attention to the following when using the Network Interface Board. When configuration is
necessary, follow the appropriate procedures below.

Connecting a Dial Up Router to a Network

When the NetWare file server and the printer are on the opposite side of a router, packets are continu-
ously sent back and forth, possibly causing communications charges to increase. Because the packet
transmission is a specification of NetWare, you need to change the configuration of the router. If the
network you are using does not allow you to configure the router, configure the printer.

Configuring the router

Filter the packets so that they do not pass over the dial up router.

& Note

3 The MAC address of the printer doing the filtering is printed on the printer configuration page. For
more information about printing a configuration page, see the Setup Guide that comes with the print-
er.

3 For more information about configuring the printer if the router cannot be configured, see the instruc-
tions below.
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Configuring the printer with NetWare

n Following the setup method in this manual, configure the file server.
B Set the frame type for a NetWare environment.

~ Reference
3 For more information about selecting a frame type, see Administrator Reference 1 that comes
with the printer.

Configuring the printer without NetWare

n While not printing, the Network Interface Board sends packets on the network. Set the Net-
Ware to inactive.

~ Reference
3 For more information about selecting a protocol, see Administrator Reference 1 that comes with
the printer.

PostScript Printing from Windows

When printing PostScript from Windows, see the PostScript 3 Operating Instruction Supplement pro-
vided as a PDF file on the CD-ROM labeled "Operating Instructions".
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NetWare Printing

Form Feed

You should not configure the form feed on NetWare. The form feed is controlled by the printer driver
on Windows. If the NetWare form feed is configured, the printer might not print properly. If you want
to change the form feed setting, always configure it on Windows.

With Windows 95/98/Me, clear the [Form feed] check box under the [Printer Settings] tab in the
printer properties dialog box.

With Windows 2000, clear the [Form feed] check box under the [NetWare Settings] tab in the printer
properties dialog box.

With Windows NT 4.0, clear the [Form feed] check box under the [NetWare Settings] tab in the print-
er properties dialog box.

Banner Page

You should not configure a banner page on NetWare. If you want to change the banner page setting,
always configure it on Windows.

With Windows 95/98/Me, clear the [Enable banner] check box under the [Printer Settings] tab in the
printer properties dialog box.

With Windows 2000, clear the [Enable banner] check box under the [NetWare Settings] tab in the
printer properties dialog box.

With Windows NT 4.0, clear the [Enable banner] check box under the [NetWare Settings] tab in the
printer properties dialog box.
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Printing after resetting the printer

After resetting the remote printer, it will be cut off from the print server for about 30-40 seconds before
connecting again. Due to the NetWare specification, print jobs may be accepted, but they will not be
printed during this interval.

When using the printer as a remote printer, wait about 2 minutes after resetting the printer before at-
tempting to print.

When Using DHCP

Note the following points when using DHCP (Dynamic Host Configuration Protocol).

Select "DHCP" for "Network Boot" on the panel display, If you use DHCP. See Administrator Refer-
ence 1 for more information.

Configure the printer with a reserved IP address

To always assign the same IP address, configure a reserved IP address using the DHCP server.

& Note

O When multiple DHCP servers are used, reserve the same address with each DHCP server. The Net-
work Interface Board needs to receive information from the DHCP server that it contacts.

3 If you do not know the MAC address, it can be found on the configuration page printed by the printer.
3 For details about the settings for IP address, see the Help files for the operating system you use.

3 When you select the printer in the DHCP environment using SmartNetMonitor for Client, use the
printer name that is displayed with SmartNetMonitor for Admin or shown on the configuration page.
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Additional information

When the DHCP server does not assign an IP address, the Network Interface Board uses 11.22.33.44
as a temporary IP address. You can confirm the printer's IP address on the network configuration

page.
Because 11.22.33.44 is a special IP address, you cannot print using this address.

When using the DHCP relay agent in a network environment that uses a dial up router to connect to
the Network Interface Board, an increase in communication fees can occur.
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Memory Capacity and Paper Size

Resolution Paper Size Non-Duplex Printing Duplex Printing
Can be printed | Guarantee Can be printed | Guarantee
600 x 600 dpi A3/11x17 Guarantee 64 MB 64 MB 128 MB
B4/8'/>x11 64 MB (Standard) (Standard) (Standard + 64 MB)
81/,x14 (Standard) Guarantee
A4/8'1x11 64 MB
BS (Standard)
A5
1200 x600 dpi A3/11x17 64 MB 128 MB 64 MB 192 MB
(Standard) (Standard + 64 MB) | (Standard) (Standard + 128 MB)
B4/8/x11 128 MB
81/,x14 Guarantee (Standard + 64 MB)
A4/8/px11 64 MB
BS (Standard)
AS Guarantee
64 MB

(Standard)
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Resolution Paper Size Non-Duplex Printing Duplex Printing
Can be printed | Guarantee Can be printed | Guarantee
1200 x 1200 dpi | A3/11x17 64 MB 192 MB 128 MB 320 MB
(Standard) (Standard + 128 MB) | (Standard + 64 MB) | (Standard +256 MB)
B4/8/x11 128 MB
8'/,x14 (Standard +64 MB) | 64 MB 192 MB
A4/81/>x11 (Standard) (Standard + 128 MB)
B5 128 MB
A5 Guarantee (Standard + 64 MB)
64 MB
(Standard)
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Moving and Transporting the Printer

A\ CAUTION:
+  When moving the machine, each person should hold the handle, where two are located on oppo-
site sides, and lift slowly and slowly. Lifting it carelessly or dropping it may cause an injury.

»  When you move the printer, remember to unplug the power cord from the wall outlet to avoid a
fire or an electric shock.

»  When you pull out the plug from the socket, grip the plug to avoid damaging the cord and causing
a fire or an electric shock.

& Note
O The printer weights approximately 82 kg (181 Ibs).
Repack the printer in its original packing materials for transporting.

i@klmportant
O Be sure to disconnect all cables from the printer before transporting it.

3 The printer is a precision piece of machinery. Take care to avoid damage during shipment.
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Moving the Printer

A\ CAUTION:
»  When lifting the machine, use the inset grips on both sides. Otherwise the printer could break or
cause injury if dropped.

» Before moving the machine, unplug the power cord from the outlet. If the cord is unplugged
abruptly, it could become damaged. Damaged plugs or cords can cause an electrical or fire haz-
ard.

& Note
3 The machine weight is about 82 kg (181 Ibs).

Moving the printer in the short distance

n Be sure to check the following points:
* The power switch is turned off.
* The power cable is unplugged from the wall outlet.
* The interface cable is unplugged from the printer.

ﬂ If you installed external options, remove them.
B Be sure to close the bypass tray and the front cover.
ﬂ Lift the printer and move it horizontally to the place where you want to install it.

ﬂlmportant
3 Be sure to move the printer horizontally. Moving the printer slowly avoiding the toner to scatter.

3 If the Paper Feed Unit(s) is installed, detach and move the printer separately. l y
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Specifications

Mainframe

% Configuration:
Desktop

+ Print Process:
Laser beam scanning & Electrophotographic printing
Dual component toner development

« Printing Speed:
Monochrome: Maximum 38 pages per minute (A4 [}, 11x 8'/,[J))
Color: Maximum 28 pages per minute (A4[J), 11x 8'/,[))

< Parallel Interface:
Interface
Standard 36-pin printer cable and a parallel port on the host computer
IEEE 1284 1/F (Compatible, ECP, Nibble)
* Do not use a cable more than 2.5 meters (8.2 feet) long.

< Resolution:
1,200 x 1,200 dpi (RPCS, PostScript 3)
1,200 x 600 dpi (RPCS, PostScript 3)
600 x 600 dpi (PCL 5c, RPCS, PostScript 3)
300 x 300 dpi (PCL 5c) *monochrome only




Administrator Reference 2

+ Printer Language:
PCL 5c, RPCS, Adobe PostScript Level 3

% Fonts:
PCL 5¢
Agfa Font 35 Manager Intellifonts, 10 TrueType fonts, and 1 Bitmap font Agfa
Font Manager available, 31 fonts.
PostScript 3
136 fonts (Type 2:24, Type 14:112)

< Paper size:
See "Paper and Other Media" in Maintenance Guide 2.

< Paper Weight:
See "Paper and Other Media" in Maintenance Guide 2.

< Power Source:
120 V, 60 Hz, 10 A

< Power Consumption:

Printing 1200 W or less

Energy Saver 45 W or less

< Noise Emission ":
Sound Power Level

Mainframe only

During Printing 68 dB (A)
Stand-by 42 dB (A)
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Sound Pressure level 2

Mainframe only

During Printing

55dB (A)

*I' The preceding measurements made in accordance with ISO7779 are actual values.

2 Measured at the position of a bystander.

2o

% Dimensions:

Width

Depth Height

Printer only (tray not ex- | 575 mm (22.7")
tended)

648 mm (25.6") 715 mm (28.2")

With full options 1,110 mm (44")

648 mm (25.6") 985 mm (38.9")

< Weight:

Approximately 82 kg (181 lbs) (toner cartridge and power cord included)

< Warm-up Time:
Less than 120 seconds (23°C, 73F)

< Paper Input Capacity:

Standard paper tray

500 sheets x 2 *!

Bypass tray 2

100 sheets !

Optional Paper Feed Units

500 sheets x 1,500 sheets x2 *!

Paper Bank PS470

2,000 sheets *!

*I' Paper weight: 60 - 105 g/m? (16 - 28 1b)

2 You can load up to 10 envelopes at the same time.
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< Paper Output Capacity:
Face down: 500 sheets (80 g/mz, 20 1b)
Face up: 100 sheets (80 g/m?, 20 1b)

< Paper weight and number of sheets to be set:

Supported paper weight Ma)fimum number of sheets
(plain paper)
Tray 1 60 - 105 g/m? (16 - 28 1b) 550 (80 g/m?, 20 Ib)
Tray 2 60 - 105 g/m? (16 - 28 1b) 550 (80 g/m?, 20 Ib)
Bypass Tray 52 -162 g/m2 (14 - 42 1b) 100 (80 g/mz, 20 Ib)
PAPER FEED UNIT Type 3800C (500 x 1) | 60 - 105 g/m? (16 - 28 1b) 500 (80 g/m?, 20 1b)
PAPER FEED UNIT Type 3800C (500 x 2) | 60 - 105 g/m? (16 - 28 1b) 500 (80 g/m?, 20 1b)
Paper Bank PS470 60 - 105 g/m? (16 - 28 1b) 2000 (80 g/m?, 20 1b)

< Memory:
Standard 64 MB, up to 384 MB (with the optional Memory Unit)

+ Network:
Topology: Ethernet (10BaseT/100BaseTX)
Protocol: TCP/IP, NetBEUI, IPX/SPX, AppleTalk
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Options

PAPER FEED UNIT Type 3800C (500 x 1)

< Dimensions (WxDxH):
540 x 600 x 172 mm (21.3" x 23.7" X 6.8")

< Paper Weight:
60 - 105 g/m? (16 - 28 1b)

< Paper Size:
A5 (Long edge feed) - A3, 8!/,x11 - 11x17 (Short edge feed)

PAPER FEED UNIT Type 3800C (500 x 2)

< Dimensions (WxDxH):
540 x 600 x 270 mm (21.3" x 23.7" x 10.7")

< Paper Weight:
60 - 105 g/m? (16 - 28 1b)

< Paper Size:
A5 (Long edge feed) - A3, 8'/,x11 - 11x17 (Short edge feed)
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Paper Bank PS470 (Large capacity tray)

< Dimensions (WxDxH):
540 x 600 x 270 mm (21.3" x 23.7" x 10.7")

< Paper Weight:
60 - 105 g/m? (16 - 28 1b)

% Paper Size:
A4 (Long edge feed) or 8'/,x11 (Short edge feed)

SR770 (2 Tray Finisher)

% Dimensions (WxDxH):
680 X 620 x 1,030 mm (26.8" x 24.4" x 40.6")

< Paper Size:
A5 (Long edge feed) - A3, 8'/,x11 - 11x17 (Short edge feed)

< Paper Weight:
60 - 105 g/m? (16 - 28 Ib)
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% Stack Capacity:
* Upper Tray:
500 sheets (A4/11x8!/,/B5/A5 (Long edge feed) - 80 g/m?, 20 Ibs.)

* Lower Tray
2,000 sheets (A4/11x8'/, (Long edge feed) - 80 g/m?, 20 1bs.)
750 sheets (A3, B4, A4 (Short edge feed), B5, 8!/,x14, 11x17, 8'/,x11 (Short edge feed))
500 sheets (AS (Long edge feed))

< Weight:
53 kg (116.9 1b)

Mail Bin Type 3800C (4bin Mail Box)

% Dimensions (WxDxH):
540 x 600 x 400 mm (21.3" x 23.6" x 15.8")

% Paper Size:
A5 (Long edge feed) - A3, 8'/,x11 - 11x17 (Short edge feed)

< Paper Weight:
60 - 105 g/m? (16 - 28 1b)

< Stack Capacity:
125 sheets / bin (A4 (Long edge feed) 80 g/m?)

< Weight:
7 kg (15.5 Ib)
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Duplex Unit Type 3800C

< Dimensions (WxDxH):
90 x 524 x 430 mm (3.6" x 20.7" x 17.0")

% Paper Size:
A5 (Long edge feed) - A3, 17x11 - 10'/,x7'/4 (Long edge feed)

< Weight:
8 kg (3.6 1b)

Printer Hard Disk Type 3800C

% Storage Capacity (Formatted):
20 GB, 40 GB

* Spool print data to collate

* Spool Sample/Locked Print data
» Store PostScript fonts

» Store log data

& Note

3 You can install PostScript fonts with this optional Hard Disk Drive. With Macintosh, types of fonts
supported are PostScript Type 1 and PostScript Type 2. To download them, use Printer Utility
for Mac.

O When you install optional scanner unit, 40 GB printer hard disk must be required to use docu-
ment server function.

g
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Memory Unit TypeB 64/128/256MB

< Module Type:
SO-DIMM (Small Outline Dual-in-line Memory Module)

< Memory Type:
SDRAM (Synchronous Dynamic RAM)

< Number of Pins:
144 pins

User Account Enhance Unit TypeB

% Capacity:
64 KB
» Store User Code (Up to 400 users)

1394 Interface Unit Type 1045

% Interface:
IEEE Std 1394-1955 compliant, IEEE Std 1394-2000 compliant.

< Interface Connector:
IEEE 1394 (6 pin X 2)
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< Required cable:
1394 interafce cable (6 pin x 4 pin, 6 pin x 6 pin)

{¥Important
3 You cannot plug devices together so as to create loops.
3 Do not use a cable more than 4.5 meters long.

< Connectable number of device in a bus:
Maximum 63

< Allowed cable hops in a bus:
Maximum 16

< Data Transmission:
400 Mbps (Maximum)

< Power supply:
Non power supply
Cable Power repeated (IEEE 1394a-2000 compliant)

iﬁklmportant

3 In Windows 2000, the 1394 Interface Unit can only be used with Service Pack 1 or later. If the Ser-
vice Pack is not installed, the connectable number of device in a 1394 bus is only one, and the client
cannot access the 1394 Interface Unit without using an account has the Administrators permission.

3 The optional 1394 Interface Unit is not supported by Windows 95/98/Me. If the "plug and play" func-
tion starts, click [Cancel] in the [New Hardware Found] or [Device Driver Wizard] dialog box.

3 Do not plug or unplug the 1394 interface cable while installing the printer driver.
O Do not turn off or on the device while installing the printer driver.

3 Do not uninstall the printer driver, when the 1394 Interface Unit is installed. Unplug the 1394 inter-
face cable to uninstall the printer driver.

I_'/ z
,//
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& Note

O The 1394 Interface Unit could not receive data from more than one PC at the same time. In this
case, an error message appears. The printer can accept data sent from other PCs, after the first
print job has finished.

3 The bidirectional transmissions are not supported by the 1394 Interface Unit.

3 When the 1394 Interface Unit is installed successfully, the printer icon automatically changes from
"Use Printer Offline" to "Ready ", according to the 1394 interface cable plug.
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configuration
NetWare, 40
1394 Interface Unit Type 1045, 187 NetWare 3.x, 41
NetWare 4.x, 5, 49
A Web Browser, 124

Windows NT 4.0, 26
Configuring, 59
Configuring NetBEUI for Printing
Windows 2000, 12
Windows NT 4.0, 28

access control address, 132
access control mask, 132
ARP+PING, 134

Auto Continue, 93

B Configuring the Printer using
SmartNetMonitor for Admin, 118
BOOTP, 134 Configuring the Protocols

Windows 2000, 10

Bypass size, 73
Windows NT 4.0, 26

C

cable, 179, 188
Changing Names and Comments, 59

D

default gateway address, 132

SmartNetMonitor for Admin, 60 DHCP, 134,173
Web Browser, 62 dial up router, 170
Changing Port Settings Displaying the Status of Printer, 64
Windows 2000, 17 SmartNetMonitor for Admin, 64
Windows NT 4.0, 33 SmartNetMonitor for Client, 65
Color Demo Page, 80 Web Browser, 66
community name, 138 Duplex, 93
Config. Page, 80, 81 Duplex Unit Type 3800C, 186
Configuration

Windows 2000, 10
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E install
SmartNetMonitor for Admin, 42,50
Energy Saver 1, 93 Installing by "Network" installation
Escape key, 71 Windows 2000, 14
Installing Software
F Windows 2000, 14

Windows NT 4.0, 30
I/0 Buffer, 102
I/0 Timeout, 102
IP address, 131

Font Number, 109
Font Pitch, 109
fonts, 180

Font Source, 109 IPP, 141

Form Lines, 109 IPP for Printing
G Windows 2000, 10
Windows NT 4.0, 26

Getting Printer Information over the Network, 146

H

Job Separation, 93
HDD Format, 87
Hex Dump, 80 L

Host Interface, 70, 102 LAN adapter number (Lana Number), 28

| Language, 70,115
List/Test Print, 70, 80
Image Density, 87 List/Test Print Parameters, 80
information Locked Print, 70

Network Interface Board configuration, 137,161
print job, 159

print log, 160

system log, 137,164
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Mail Bin Type 3800C, 185

Maintenance, 70, 87, 88

Making Printer Settings with the Operation Panel, 67

memory, 182

Memory Capacity and Paper Size, 175

Memory Overflow, 93

Memory Unit TypeB, 187

menu, accessing, 70
menu, changing, 115
Menu Chart, 67
Menu key, 70
Menu List, 80
Menu Protect, 87
message, 164

MIB, 128
MisfeedRecovery, 93
Monitoring, 59
Moving the Printer, 178

N

Network Setup, 102
NIB, 182

o)

On Line key, 72
options, 183

Orientation, 109
Output Tray, 93

P

NetWare, 40
NetWare 3.x, 41
NetWare 4.x, 5, 49
NetWare Printing, 172
Network Boot, 134
"Network Install"

Windows NT 4.0, 30

Network Interface Board, 182

Page Size, 93
Paper Bank PS470, 184
PAPER FEED UNIT Type 3800C, 183
Paper Input, 70,73
Paper type, 73
password, 126, 144
PCL, 109
PCL Config.Page, 80
PCL Menu, 70
Point Size, 109
PostScript Printing from Windows, 171
precautions, 170
Printer Hard Disk Type 3800C, 186
Printer Shared
Windows 2000, 25
Windows NT 4.0, 39
printer status, 136
Prt. Err Report, 93
PS Config. Page, 80
Pure IP, 53
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R SR770 (2 Tray Finisher), 184
subnet mask, 132
RARP+TFTP, 134 Sub Paper Size, 93
Registration, 87 Symbol Set, 109
remote printer, setup System, 70, 93
NetWare 4.x, 5, 55
Resolution, 93 T
S TCP/IP for Printing
Windows 2000, 10
Sample Print, 70 Windows NT 4.0, 26
SDRAM, 182,187 telnet, 129
Setting The conditions of the bidirectional transmissions,
client computer, Windows 2000, 25 23,37
Setting Up as a Print Server Tray Locking, 73

NetWare3.x, 43
NetWare4.x/NetWare5.1, 51
Setting Up as a Remote Printer

Tray Paper Size, 73
Tray Priority, 73

NetWare3.x, 45 U
NetWare4.x/NetWare5.1, 55
Setting Up Options Understanding the Displayed Information, 159
Windows 2000, 22 Unit of Measure, 93
Windows NT 4.0, 36
setup w

client computer, Windows NT 4.0, 39

SmartNetMonitor for Admin Wffb Browser, 124
install, 42,50 Windows 2000, 10

SMB, 142 Windows NT 4.0, 26

SNMP, 128, 138
specifications, 179
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